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●PETUNJUK KESELAMATAN●
(Selalu baca petunjuk ini sebelum menggunakan produk ini.)

Sebelum mendesain sebuah sistem, pastikan untuk membaca manual yang relevan secara 
cermat dan tangani produk dengan benar dengan perhatian penuh pada keselamatan.

[PETUNJUK KESELAMATAN TENTANG PELATIHAN PRAKTIS DALAM DOKUMEN INI]

PERINGATAN
• Saat menyala, jangan sentuh terminal agar tidak menyebabkan kecelakaan kejut 

listrik.

• Sebelum membuka penutup keselamatan, matikan sistem atau dapatkan lingkungan 
yang aman.

PERHATIAN
• Saat memasang atau melepaskan modul atau unit, matikan dahulu.  

Memasang atau melepaskan saat menyala dapat mengakibatkan kerusakan modul 
atau unit atau kejut listrik.

• Jika kesalahan atau malafungsi terjadi, segera stop penggunaan modul atau unit.

[GOT2000-MANUAL YANG RELEVAN]

Untuk informasi detail, baca masing-masing manual GOT2000.

Jika Anda memerlukan manual yang sudah dicetak, hubungi kantor cabang atau 

perwakilan Mitsubishi setempat Anda.

* Dokumen ini menggunakan GT Designer3(GOT2000) Version1.153K untuk penjelasan.

Bergantung pada versi yang digunakan, tampilan menu dan layar mungkin berbeda.
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GOT adalah singkatan dari “Graphic Operation Terminal”.

Sakelar dan lampu telah dipasang secara konvensional pada panel pengoperasian sebagai hardware. Namun, dengan 
menekan software desain layar, sakelar dan lampu tersebut dapat dibuat, ditampilkan, dan dioperasikan di layar 
monitor GOT, HMI panel sentuh.

Hemat
ruang

GOT

Pengurangan
biaya

Panel operasi
konvensional

Keuntungan GOT
(1) Mermperkecil ukuran panel pengoperasian

Karena sakelar dan lampu dibuat menggunakan software, jumlah komponen yang dipasang pada panel 
pengoperasian sebagai hardware dapat dikurangi dan panel itu sendiri bisa diperkecil ukurannya.

(2) Menghemat biaya untuk pengkabelan
Pengkabelan antar komponen di dalam panel pengoperasian dengan desain layar oleh software, menghilangkan 
kebutuhan untuk pengkabelan, yang memakan banyak waktu dan biaya.

(3) Menstandarkan panel pengoperasian
Meskipun spesifikasi yang diperlukan berubah, Anda hanya perlu mengubah pengaturan menggunakan software.
Oleh karena ini, panel pengoperasian dapat distandarkan.

(4) Menambah nilai ekstra sebagai HMI (Human Machine Interface)
GOT bisa dengan mudah menampilkan grafis, teks, dan alarm selain dari sakelar dan lampu.
Oleh karena itu, nilai ekstra seluruh peralatan Anda bisa ditingkatkan.

FITUR GOT
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Tampilan dan antarmuka GOT yang disempurnakan
Yang berikut ini menampilkan tampilan dan antarmuka GOT2000 yang disempurnakan

[Permukaan depan]

* GT27 (15 inch dan 12,1 inch saja)

GOT mendeteksi operator dan 
otomatis menampilkannya di layar. 
Saat tidak ada orang, 
lampu latar mati untuk
menghemat energi.

Desain yang sederhana dengan 
motif linear tampil mulus dan 
melengkapi desain mesin apa pun.

Data dapat ditransfer tanpa 
membuka lemari.

Siklus hidup yang panjang 
meminimalkan biaya pemeliharaan 
dan penggantian. 

Data layar dapat ditransfer 
dan data dalam GOT bisa diambil 
menggunakan memori USB. 
Mouse dan keyboard USB 
dapat disambungkan.

Sensor kedekatan Desain sederhana

Lampu latar LED

Perangkat USB

Host USB

* Perangkat USB ada di permukaan belakang 
untuk model putih dan GT21.

* GT27 dan GT25 saja. Host USB ada di 
permukaan belakang untuk model putih.

[Permukaan belakang]

Antarmuka ekstensi

Ethernet

RS-422/485

Slot kartu SD

Unit komunikasi dan opsi 
dapat dipasang.

Berbagai perangkat FA, 
pembaca barcode, 
printer serial bisa 
disambungkan.

Data dalam jumlah besar termasuk 
data alarm dan data pencatatan 
bisa disimpan.

Berbagai perangkat FA dapat 
disambungkan.

Hingga empat tipe PLC dari 
produsen berbeda* bisa 
dipasang bersamaan 
melalui Ethernet.

Antarmuka sisi

Host USB

Perangkat memori USB dapat 
dipasang untuk menyimpan 
alarm dan data pencatatan. 
Mouse dan keyboard USB 
dapat disambungkan.

RS-232

* GT27 dan GT25 saja

* Gambar ini adalah GT2712. * GT27 dan GT25 saja

Perangkat USB

GOT bisa disambungkan 
ke komputer pribadi 
untuk mentransfer data.
* Model putih saja

* Hingga dua tipe PLC untuk GT21
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MENYIAPKAN PERANGKAT YANG DIPERLUKAN
PERANGKAT YANG DIPERLUKAN UNTUK MENGOPERASIKAN GOT

Untuk mengoperasikan GOT, GOT ( 1 ), kabel ( 2 ), komputer pribadi dan software, ( 3 ), dan pengontrol ( 4 ) diperlukan.

GOT2000 (GT27)

Kabel USB 
(GT09-C30USB-5P)

Kabel Ethernet

PLC 

GOT Kabel Komputer pribadi dan software

Pengontrol

2 3

4

Komputer pribadi

GT Designer3 (GOT2000) 
Bantuan GT Designer3 (GOT2000)

GX Works3

1

Referensi

Untuk mengetahui cara menginstal software desain layar, rujuk ke yang berikut.

 ● GT Works3 Installation Instructions BCN-P5999-0066/0071

Untuk metode penyambungan GOT dan pengontrol, rujuk ke yang berikut.

 ● GOT2000 Series Connection Manual (Mitsubishi Products) For GT Works3 Version1 SH-081197ENG
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GT Designer3 adalah software yang digunakan untuk membuat layar untuk seri GOT2000 dan seri GOT1000.
Software ini memungkinkan Anda membuat dan mensimulasikan project serta mentransfer data antara GOT dan 
komputer pribadi.

Simulasi pembuatan

project

Komputer pribadi (GT Designer3)

Transfer data

GOT

GT Designer3 terdiri dari software desain layar berikut.
 ● GT Designer3(GOT2000): Software desain layar untuk seri GOT2000

 ● GT Designer3(GOT1000): Software desain layar untuk seri GOT1000

Dokumen ini menguraikan tentang membuat layar untuk GOT2000 dengan GT Designer3(GOT2000).

Gambar layar GT Designer3(GOT2000)

FITUR GT Designer3
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TATA LETAK LAYAR GT Designer3

Yang berikut ini menampilkan tata letak layar GT Designer3.
1

2

3

4

5

6

7

8
3

4

3

1  Title bar (Bilah judul)
Menampilkan nama software, nama project, dan nama file.

2  Menu bar (Bilah menu)
GT Designer3 bisa dioperasikan dari menu tarik turun.

3  Toolbar (Bilah alat)
GT Designer3 bisa dioperasikan oleh tombol. Anda bisa menempatkan toolbar di kiri, kanan, atas, atau bawah.

4  Docking window (Jendela penambatan)
Jendela bisa ditambatkan dengan layar GT Designer3.

5  Editor tab (Tab Editor)
Menampilkan tab jendela dan editor layar yang ditampilkan di jendela kerja.

6  Work window (Jendela kerja)
Menampilkan editor layar, jendela [Environmental Setting], jendela [GOT Setup], dan jendela lain.

7  Screen editor (Editor layar)
Membuat layar untuk ditampilkan di GOT dengan menempatkan angka dan objek di editor layar.

8  Status bar (Bilah status)
Menampilkan informasi sesuai dengan posisi kursor mouse, status gambar atau objek yang dipilih.
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(a) Jendela bertumpuk

(c) Key windows
(d) Jendela dialog

(b) Overlap windows

Layar dibuat dengan GT Designer3 Layar yang ditampilkan di GOT

348BA1254

Layar status produksi 1

Layar dasar

348BA1254

Layar status produksi 1

Layar dasar

Layar jendela

(1) Layar dasar
Layar yang ditampilkan sebagai layar dasar GOT.
Perangkat peralihan layar mengendalikan tampilan layar dasar.

(2) Layar jendela
Layar yang ditampilkan sebagai overlap windows, jendela bertumpuk, key windows, dan jendela dialog GOT.

(a) Jendela bertumpuk
Jendela bertumpuk di layar dasar dan ditampilkan sebagai bagian dari layar dasar.
Hingga dua jendela bertumpuk (jendela bertumpuk 1 dan 2) bisa ditampilkan secara bersamaan.
Perangkat peralihan layar mengendalikan tampilan layar jendela.

(b) Overlap windows
Jendela pop-up yang ditampilkan di atas layar dasar.
Hingga lima overlap windows (overlap windows 1 hingga 5) bisa ditampilkan secara bersamaan.
Posisi tampilan overlap windows bisa dipindah dengan operasi sentuh atau perangkat spesifikasi posisi tampilan.
Perangkat peralihan layar mengendalikan tampilan layar jendela.
(GT21 bisa menampilkan hingga dua overlap windows (overlap windows 1 dan 2) secara bersamaan.)

(c) Key windows
Jendela pop-up yang ditampilkan di layar dasar untuk input numerik dan yang lainnya.
Posisi tampilan key windows bisa dipindahkan dengan operasi sentuh.
Disediakan dua tipe key windows: Key windows standar GOT dan key windows buatan pengguna.

(d) Jendela dialog
Jendela yang menampilkan pesan kesalahan, pesan peringatan, dan pesan sistem GOT di latar depan.
Saat jendela dialog ditampilkan, layar lain tidak bisa dioperasikan.
Perangkat peralihan layar mengendalikan tampilan layar jendela.

(3) Layar laporan
Jendela untuk keluaran data oleh fungsi laporan.
Layar ini tidak ditampilkan di GOT.

LAYAR YANG BISA DIBUAT DENGAN GT Designer3
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MEMO
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1LANGKAH 1 

MEMBUAT PROJECT
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Layar berikut akan dibuat di bagian ini.

1 2

6

3

5
4

1 Sakelar RUN, Sakelar STOP
Sentuh sakelar untuk menyalakan atau mematikan perangkat bit PLC.
→ 1.2.1 Membuat Sakelar RUN
→ 1.2.2 Membuat Sakelar STOP

2 Lampu RUN
Menyalakan atau mematikan sesuai dengan status perangkat bit PLC.
→ 1.2.3 Membuat Lampu RUN

3 Tampilan numerik
Menampilkan nilai yang disimpan di PLC.
→ 1.2.4 Membuat Tampilan Numerik

4 Gambar (Persegi)
Letakkan persegi untuk membuat sakelar dan lampu lebih terlihat.
→ 1.3.1 Membuat Gambar (Persegi)

5 Gambar (Teks) 1 hingga 5
Karakter yang mendeskripsikan layar, sakelar, dan lampu ditampilkan.
→ 1.3.2 Membuat Bentuk (Teks) 1 hingga 3
→ 1.3.3 Membuat Gambar (Teks) 4 dan 5

6 Sakelar gerakan layar
Cubit layar untuk memperbesar layar dan renggangkan untuk memperkecil layar dengan sakelar ini.
→ 1.4 MENYETEL FUNGSI GERAKAN LAYAR

1.1 MEMBUAT PROJECT BARU
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1

(1) Membuat project baru
Mulai GT Designer3(GOT2000) dan ikuti wizard untuk mengonfigurasi pengaturan.

Klik!

1

1 Pilih [MELSOFT Application] → [GT Works3] → 
[GT Designer3] dari menu mulai Windows.

Klik!

2
2 Klik tombol [New] dalam dialog Select Project.

Klik!

3

3 Klik tombol [Next] di layar mulai New Project 
Wizard.
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Petunjuk

GT Designer3 bisa dimulai dari desktop jika ikon pintasan dibuat 

selama instalasi.

Klik!

4

4 Periksa pengaturan sistem di jendela 
pengaturan sistem dan klik tombol [Next].
• Series: GOT2000

• GOT Type: GT27**-V (640×480)

• Use the gesture function: Dipilih

• Standard Language: English

• Outline Font

Alphanumeric/Kana: Dipilih

Kanji: Dihapus

Hangul: Dihapus

Klik!

5

5 Periksa pengaturan yang ditampilkan dan klik 
tombol [Next].

Klik!

7

Pilih 6

6 Pilih [MELSEC iQ-R, RnMT/NC] di daftar drop-
down [Controller Type] di jendela pengaturan 
komunikasi.

7 Klik tombol [Next].
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1

Klik!

9

Pilih 8

8 Pilih [Standard(Ethernet):Multi] di daftar 
dropdown [I/F].

9 Klik tombol [Next].

Klik!

10

10 Periksa driver komunikasi yang ditampilkan 
dan klik tombol [Detail Setting].
Communication Driver: Ethernet(MELSEC), 
Q17nNC, CRnD-700, Gateway

Klik!

11

Klik!

12

11 Jendela yang ditunjukkan di kiri muncul. Ubah 
nilai [GOT Station].
GOT Station: 2

12 Klik tombol [OK].

Petunjuk

Klik tombol [GOT Standard Ethernet Setting] untuk mengubah alamat IP GOT.
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Klik!

13

13 Klik tombol [Next].

Klik!

14

14 Periksa pengaturan yang ditampilkan dan klik 
tombol [Next].

Klik!

15

15 Periksa perangkat peralihan layar di layar dasar 
dan klik tombol [Next].
Base Screen: GD100 (Default)



1-7

1

Klik!

16

16 Periksa pengaturan dengan wizard lalu klik 
tombol [Finish].

Layar pengeditan GT Designer3(GOT2000) muncul, dan layar dasar 1 dibuat.
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 ■ Ketika GT Designer3(GOT1000) dimulai

GT Designer3 memulai software desain layar yang digunakan untuk menyimpan project sebelumnya.

Saat software desain layar untuk GOT1000 dimulai

Ketika GT Designer3(GOT1000) dimulai, mulai software desain layar untuk GOT2000 dengan salah satu metode berikut.
(1) Memulai GT Designer3(GOT2000) dari menu

Pilih [Project] → [Start GT Designer3(GOT2000)] dari menu bar untuk memulai GT Designer3(GOT2000).

(2) Memulai GT Designer3(GOT2000) dari wizard
Pilih [GOT2000] untuk [Series] dalam dialog [New Project Wizard] untuk memulai GT Designer3(GOT2000).
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1

(1) Menempatkan sakelar
Pilih [Object] → [Switch] → [Bit Switch] dari menu bar untuk menempatkan sakelar.

Petunjuk

Anda juga bisa memilih item dari toolbar.

Petunjuk

Menempatkan objek

Ketika objek dipilih dari menu atau toolbar, bentuk kursor berubah menjadi “+”.

Klik area mana pun tempat objek akan ditempatkan di editor layar.

Klik Tempat

Objek bisa ditempatkan dalam ukuran apa pun saat menempatkannya dengan menyeret kursor.

Seret Tempat

(2) Menyetel perangkat dan tindakan

Klik
dua kali!

1

1 Klik dua kali sakelar yang ditempatkan.

1.2 MEMBUAT OBJEK
1.2.1 Membuat Sakelar RUN
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Setel “Device: M0” dan 
“Action: Momentary”.

2

Ketika dialog yang ditunjukkan di kiri muncul, setel 
item berikut.

2 Device: M0
Action: Momentary

Poin

Menyetel perangkat

Klik  untuk menyetel perangkat.

Klik!

Poin

Perangkat bisa juga disetel dengan memasukkannya langsung  

menggunakan keyboard.

Langsung masukkan 
perangkat dan 
tekan tombol Enter.
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1

(3) Menyetel teks

Klik!

3

Masukkan “RUN” 
in Text.

4

Klik!

5

3 Pilih tab Text.

4 Masukkan “RUN” dalam Text.

5 Klik tombol [OK].

Membuat sakelar RUN selesai.

Referensi

Jika Anda punya pertanyaan, tekan tombol F1 untuk memulai bantuan GT Designer3(GOT2000). 

Halaman bantuan yang relevan dengan operasi yang Anda lakukan ditampilkan.
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 ■ Tindakan sakelar bit

Sakelar bit menyalakan dan mematikan perangkat bit yang ditentukan oleh sakelar.
Yang berikut ini ditampilkan oleh tindakan yang bisa disetel dengan sakelar bit.

(1) Bit momentary
Mempertahankan perangkat bit tertentu hanya saat Anda menyentuh sakelar.

X0001: OFF

STOP

X0001: OFF

STOP

X0001: ON

RUN

X0001: OFF

STOP

X0001: ON

RUN

(2) Bit alternate
Menyelang-nyeling status perangkat bit yang ditentukan (ON←→OFF) saat Anda menyentuh sakelar.
X0001: OFF

STOP

X0001: ON

RUN

X0001: ON

RUN

X0001: ON

RUN

X0001: OFF

STOP

X0001: OFF

STOP

(3) Bit set
Menyalakan perangkat bit yang ditentukan saat Anda menyentuh sakelar.
X0001: OFF

STOP

X0001: ON

RUN

X0001: ON

RUN

X0001: ON

RUN

X0001: ON

RUN

X0001: ON

RUN

(4) Bit reset
Mematikan perangkat bit yang ditentukan saat Anda menyentuh sakelar.

X0001: OFF

STOP

X0001: ON

RUN

X0001: OFF

STOP

X0001: OFF

STOP

X0001: OFF

STOP

X0001: OFF

STOP



1-13

1

(1) Menyalin sakelar RUN

Seret sakelar 
sambil menekan 
tombol Ctrl. 2

Klik!

1
1 Pilih sakelar RUN.

2 Seret sakelar sambil menekan tombol Ctrl.

(2) Mengubah perangkat salin sakelar RUN

Klik
dua kali!

3

3 Klik dua kali sakelar RUN yang disalin.

Ubah perangkat 
dari “M0” ke “M1”. 4

4 Ketika dialog yang ditunjukkan di kiri muncul, 
ubah perangkat sebagai berikut.
Device: M0 → M1

1.2.2 Membuat Sakelar STOP
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(3) Mengubah warna bentuk sakelar

Klik!

5

Klik!

6
Klik!

8

Ubah warna dari 
“Blue” ke “Red”.

7 9

5 Pilih tab Style.

6 Pilih bentuk status mati.

7 Pilih warna bentuk.
Blue → Red

8 Pilih bentuk status nyala.

9 Pilih warna bentuk.
Blue → Red

(4) Mengubah teks sakelar

Klik!

10

Ubah teks 
dari “RUN” ke 
“STOP”. 11

Klik!

12

10 Pilih tab Text.

11 Masukkan “STOP” dalam Text.

12 Klik tombol [OK].

Membuat sakelar STOP selesai.
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 ■ Lembar properti

Lembar properti menampilkan daftar atribut dan nilai yang ditetapkan pada layar, gambar, atau objek yang dipilih.
Pengaturan bisa diperiksa atau diubah tanpa membuka dialog pengaturan.
Nilai yang disetel bisa diubah secara kolektif dengan memilih beberapa gambar atau objek di layar yang sama.

Mengubah perangkat Mengubah warna bentuk Mengubah teks

Referensi

Untuk mengetahui cara menampilkan lembar properti dan cara menyetel setiap item, baca bantuan atau GT 

Designer3(GOT2000) Screen Design Manual.
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(1) Menempatkan lampu
Pilih [Object] → [Lamp] → [Bit Lamp] dari menu bar untuk menempatkan lampu.

Petunjuk

Anda juga bisa memilih item dari toolbar.

(2) Menyetel perangkat, bentuk, dan warna untuk lampu

Klik
dua kali!

1

1 Klik dua kali lampu yang ditempatkan.

Ubah warna dari 
“Red” ke “Green”. 4 6

Klik!

3

Klik!

5

Setel “Y0010”.
2

Ketika dialog yang ditunjukkan di kiri muncul, setel 
item berikut.

2 Device: Y0010

3 Pilih bentuk status mati.

4 Pilih warna bentuk.
Red → Green

5 Pilih bentuk status nyala.

6 Pilih warna bentuk.
Red → Green

1.2.3 Membuat Lampu RUN
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1

(3) Menyetel teks untuk lampu

Klik!

7

Pilih 
“12”. 9

Masukkan 
“STOP”. 10

Klik!

8

7 Pilih tab Text.

8 Pilih bentuk status mati.

9 Text Size: Pilih 12 dot.

10 Masukkan “STOP” dalam Text.

Klik!

12 Pilih 
“Black”. 13

Klik!

11

Masukkan 
“RUN”. 14

Klik!

15

11 Centang kotak centang untuk “OFF=ON”.

12 Pilih bentuk status nyala.

13 Pilih Black untuk Text Color.

14 Masukkan “RUN” dalam Text.

15 Klik tombol [OK].

Membuat lampu RUN selesai.
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 ■ Menampilkan objek di editor layar

Status objek yang akan ditampilkan di editor layar dan tampilan atau tidak ditampilkannya informasi yang disetel bisa 
diganti.

(1) Mengganti status objek yang akan ditampilkan di editor layar
(a) Mengganti status antara ON dan OFF

Pilih [View] → [Switch ON/OFF Display] dari menu untuk mengganti antara gambar status aktif atau gambar 
status tidak aktif masing-masing objek di editor layar.
Jika status disetel untuk suatu objek, tampilan objek tersebut berganti antara OFF dengan status No.0 dan ON 
dengan status No.1.

(b) Mengganti status dengan menentukan No. status
Pilih [View] → [State No.] → [Previous State] atau [Next State] dari menu untuk mengubah tampilan objek di 
editor layar sesuai dengan No. status.
Jika status suatu objek diganti antara ON dan OFF, tampilan objek tersebut berganti antara OFF dengan status 
No.0 dan ON dengan status No.1 atau lebih.

Status No.0 Status No.1 Status No.63

•••

(2) Informasi pengaturan yang akan ditampilkan di editor layar
(a) Perangkat

Pilih [View] → [Display Items] → [Device] dari menu untuk berganti antara menampilkan atau 
menyembunyikan perangkat di editor layar.

(b) Perangkat label sistem
Pilih [View] → [Display Items] → [Device of System Label] dari menu untuk berganti antara menampilkan dan 
menyembunyikan perangkat yang dipilih untuk label sistem di editor layar.
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1

(c) ID Objek
Pilih [View] → [Display Items] → [Object ID] dari menu untuk berganti antara menampilkan dan 
menyembunyikan ID objek di editor layar.

(d) Cat
Pilih [View] → [Display Items] → [Paint] dari menu untuk berganti antara menampilkan dan menyembunyikan 
cat di editor layar.

(e) Objek
Pilih [View] → [Display Items] → [Object] dari menu untuk berganti antara menampilkan atau menyembunyikan 
objek di editor layar.

(f ) Bingkai objek
Pilih [View] → [Display Items] → [Object Frame] dari menu untuk berganti antara menampilkan dan 
menyembunyikan bingkai objek di editor layar.

(g) Informasi template
Pilih [View] → [Display Items] → [Template Information] dari menu untuk berganti antara menampilkan dan 
menyembunyikan informasi template di editor layar.
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(h) Area sentuh
Pilih [View] → [Display Items] → [Touch Area] dari menu untuk berganti antara menampilkan dan 
menyembunyikan area sentuh editor layar.

(i) Opsi
Pilih [View] → [Display Items] → [Option] dari menu untuk menampilkan dialog [Option].
Dalam dialog ini, Anda bisa mengonfigurasi pengaturan yang ditampilkan di editor layar.

Referensi

Untuk detail tentang opsi, baca bantuan atau GT Designer3(GOT2000) Screen Design Manual.

 ■ Operasi menggunakan toolbar

Tampilan objek juga bisa diganti menggunakan toolbar [View].

Sakelar tampilan ON/OFF No. Status

Perangkat

Perangkat label sistem

ID Objek
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1

(1) Menempatkan tampilan numerik
Pilih [Object] → [Numerical Display/Input] → [Numerical Display] dari menu bar untuk menempatkan tampilan 
numerik.

Petunjuk

Anda juga bisa memilih item dari toolbar.

(2) Menyetel perangkat dan ukuran nomor untuk tampilan numerik

Klik
dua kali!

1

1 Klik dua kali tampilan numerik yang 
ditempatkan.

Setel “D10”.
2

Pilih 
“36”. 3

Ketika dialog yang ditunjukkan di kiri muncul, setel 
item berikut.

2 Device: D10

3 Number Size: Pilih 36 dot.

1.2.4 Membuat Tampilan Numerik
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(3) Menyetel bentuk dan warna bingkai untuk tampilan numerik

Klik!

4

Pilih “Square_3D_Fixed 
Width : Rect_12”. 5

4 Pilih tab Style.

5 Pilih “Square_3D_Fixed Width : Rect_12” untuk 
Bentuk.

Pilih 
“Gray”. 6

7
Klik!

6 Pilih Gray untuk Frame Color.

7 Klik tombol [OK].

Membuat tampilan numerik selesai.
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1

(1) Menempatkan persegi
Pilih [Figure] → [Rectangle] dari menu bar untuk menempatkan persegi.

Petunjuk

Anda juga bisa memilih item dari toolbar.

Titik mulai

Titik akhir

Klik!

1

Klik
dua kali!

2

1 Seret mouse dari titik mulai ke titik akhir sambil 
mengklik mouse.

2 Klik dua kali persegi.

(2) Mengubah pengaturan persegi

Klik!

4

Pilih 
“Pattern: □ 8”, 
”Shape Color: Gray”, 
“Type: Rounded”, 
dan “Radius: 5”.

3

Ketika dialog yang ditunjukkan di kiri muncul, setel 
item berikut.

3 Pattern: □ 8
Shape Color: Gray
Type: Rounded
Radius: 5 dots

4 Klik tombol [OK].

Membuat persegi selesai.

1.3 MEMBUAT GAMBAR
1.3.1 Membuat Gambar (Persegi)
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(3) Menyalin persegi secara berturut-turut

Pilih

5

5 Pilih persegi dan pilih [Edit] → [Consecutive 
Copy] dari menu bar.

Setel “30”.

7

Setel “3”.
6

Klik!

8

Ketika dialog yang ditunjukkan di kiri muncul, setel 
item berikut.

6 Total count after copy: X 3

7 Interval: X 30

8 Klik tombol [OK] untuk menyalin persegi secara 
berturut-turut.

Poin

Bentuk ini ditempatkan di lapisan belakang objek.
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1

(1) Menempatkan gambar (Teks) 1
Pilih [Figure] → [Text] dari menu bar untuk menempatkan gambar (Teks).

Petunjuk

Anda juga bisa memilih item dari toolbar.

Klik!

1
1 Klik mouse di area tempat teks akan 

dimasukkan.

(2) Menyetel gambar (Teks) 1

Masukkan 
“Sakelar 
RUN”. 2

Pilih 
“Black”. 3

Klik!

5

Klik!

4

Ketika dialog yang ditunjukkan di kiri muncul, setel 
item berikut.

2 Text: Sakelar RUN
(Feed saluran bisa dimasukkan setelah teks 
“Sakelar” dengan menekan tombol Enter. 
Sesuaikan ukuran karakter.)

3 Text Color: Black

4 Alignment: Center

5 Klik tombol [OK].

Membuat gambar (Teks) 1 selesai.

1.3.2 Membuat Bentuk (Teks) 1 hingga 3
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(3) Menyalin gamabr (Teks) 1 secara berturut-turut untuk membuat gambar (Teks) 2 dan 3

Pilih

6

6 Pilih gambar (Teks) 1 dan pilih [Edit] → 
[Consecutive Copy] dari menu bar.

Setel “3”. 7

Setel “75”.

8

Klik!

9

Ketika dialog yang ditunjukkan di kiri muncul, setel 
item berikut.

7 Total count after copy: X 3

8 Interval: X 75

9 Klik tombol [OK] untuk menyalin gambar (Teks) 
secara berturut-turut.
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1

(4) Mengubah teks salinan

Klik
dua kali!

10

10 Klik dua kali gambar yang disalin (Teks) 2.

Masukkan 
“Sakelar 
STOP”. 11

Klik!

12

Ketika dialog yang ditunjukkan di kiri muncul, setel 
item berikut.

11 Text: Sakelar STOP
(Feed saluran bisa dimasukkan setelah teks 
“Sakelar” dengan menekan tombol Enter. 
Sesuaikan ukuran karakter.)

12 Klik tombol [OK].

Ubah bentuk (Teks) 3 dengan prosedur yang sama.
Text: Lampu RUN
(Feed saluran bisa dimasukkan setelah teks “Lampu” 
dengan menekan tombol Enter. Sesuaikan ukuran 
karakter.)

Membuat bentuk (Teks) 2 dan 3 selesai.
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(1) Menempatkan gambar (Teks) 4
Pilih [Figure] → [Text] dari menu bar untuk menempatkan gambar (Teks).
Anda juga bisa memilih bentuk (Teks) dari toolbar.

Klik!

1
1 Klik mouse di area tempat teks akan 

dimasukkan.

(2) Menyetel gambar (Teks) 4

Masukkan “Panel 
Kontrol operasi”. 2

Pilih “Outline 
Kaisho”. 3

Pilih “36”.

4

Klik!

5

Ketika dialog yang ditunjukkan di kiri muncul, setel 
item berikut.

2 Text: Panel Kontrol operasi

3 Font: Outline Kaisho

4 Size: 36 dots

5 Klik tombol [OK].

Membuat gambar (Teks) 4 selesai.

(3) Menempatkan dan menyetel gambar (Teks) 5 dengan prosedur yang sama

Setel item berikut ini.
Text: Data 1
Font: Outline Gothic
Size: 16 dots

Membuat gambar (Teks) 5 selesai.

1.3.3 Membuat Gambar (Teks) 4 dan 5
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1

(1) Fungsi gerakan layar
Fungsi ini memungkinkan pembesaran dan pengguliran layar monitor GOT.
Konten objek yang ditampilkan bisa digulir atau diperbesar dan diperkecil dengan menyentuh langsung layar GOT 
dengan gerakan seperti mencubit dan merenggangkan.

(Contoh) Merenggangkan jari di layar untuk memperbesar konten yang ditampilkan

(Contoh) Mencubit jari di layar untuk memperkecil konten yang ditampilkan

Poin

Fungsi gerakan layar diaktifkan secara default.

Jika fungsi gerakan layar dinonaktifkan, konfigurasi pengaturan sesuai dengan prosedur berikut.

Pilih [Common] → [GOT Type Setting] dari menu bar untuk menampilkan dialog pengaturan Type Setting.

Pilih [Use the gesture function] dan klik tombol [OK].

Fungsi gerakan layar diaktifkan.

Klik!

1.4 MENYETEL FUNGSI GERAKAN LAYAR
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(2) Membuat objek untuk gerakan layar
Tempatkan sakelar untuk mengganti mode gerakan layar.

Klik!

1

1 Pilih [View] → [Docking Window] → [Library 
List] dari menu bar.

Klik!

2
2 Klik ikon  di jendela [Library List].

Klik!

3

3 Pilih [System Library] → [Search By Function] 
→ [Gesture] dari menu tarik turun yang 
ditampilkan.
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1Klik
dua kali!

4

4 Klik dua kali [Gesture_Title(VGA)].

Klik!

5

5 Gaya yang didaftarkan ditampilkan dalam 
daftar. Klik [1 Gesture01_B].

Klik!

6
6 Pindahkan kursor ke editor layar dan klik 

bagian kiri atas layar.
(Garis putus-putus yang mengindikasikan 
ukuran objek muncul.)

Objek untuk gerakan layar ditempatkan.

Poin

Fungsi objek untuk gerakan layar

 ● Beralih ke mode gerakan layar

Menyentuh sakelar ikon berikut ini ke mode gerakan layar.

Sentuh untuk 
mengganti mode.

 ● Membatalkan mode gerakan layar

Sentuh untuk 
membatalkan mode.

Menyentuh ikon berikut ini selama mode gerakan layar membatalkan 

mode gerakan layar.

 ● Tampilan skala penuh (100%)

Sentuh untuk mengubah 
tampilkan ke tampilan 
skala penuh.

Menyentuh ikon berikut ini mengubah ukuran layar yang 

diperbesar menggunakan fungsi gerakan ke ukuran aktual (100%).



1-32

(3) Menampilkan area gerakan layar tidak aktif
“Area gerakan layar tidak aktif”, area untuk 16 hingga 100 titik-titik dari bagian atas layar atau bagian bawah layar 
bukanlah target untuk memperbesar atau memperkecil dan menggulir selama penggunaan fungsi gerakan.

Klik!

7

7 Pilih [Screen] → [Screen Property] dari menu 
bar.

Klik!

9

Periksa 8

8 Pilih [Display the screen gesture inactive area].

9 Klik tombol [OK].

Menyetel fungsi gerakan layar selesai.
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1

(1) Memeriksa status tampilan nyala dan mati layar dan objek yang dibuat
Pilih [View] → [Preview] dari menu bar.

Klik!

1
1 Jendela Pratinjau Layar muncul. Klik tombol 

[ON].

Bentuk 
pada status 
ditampilkan. 2

Klik!

3
2 Bentuk objek diganti ke bentuk status nyala.

3 Mengklik tombol [OFF] menampilkan bentuk 
status mati.

1.5 MEMERIKSA LAYAR YANG DIBUAT
1.5.1 Memeriksa Tampilan (Pratinjau Layar)
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 ■ Memeriksa tampilan lampu dan sakelar setiap objek

Di jendela Pratinjau Layar, lampu dan sakelar tampilan bisa diganti untuk memeriksa tiap tampilan.

(1) Mengganti status ON/OFF

Klik kanan!

1

Klik!

2

1 Klik kanan suatu objek.

2 Pilih [ON] atau [OFF].

Bentuk status on Bentuk status o�

Bentuk status nyala atau status mati ditampilkan.
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1

(2) Mengubah nilai pratinjau tampilan numerik atau input numerik

Klik!

2

Klik kanan!

1
1 Klik kanan tampilan numerik.

2 Pilih [Change Preview Value].

Klik!

4

Masukkan 
nilai. 3

3 Masukkan nilai.

4 Klik tombol [OK].

Nilai pratinjau diubah.
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(1) Memeriksa bahwa tidak ada kesalahan dalam project
Pilih [Tool] → [Data Check] → [Check] dari menu bar.

Tampilan 
penyelesaian 1

1 Periksa bahwa pesan [Data Check is 
completed.] ditampilkan di jendela Data Check 
List dan tidak ada kesalahan.

Klik
dua kali!

2

2 Jika ada kesalahan, klik dua kali hasil untuk 
melompat ke posisi yang menyebabkan 
kesalahan atau peringatan.
Periksa kesalahan dan ubah pengaturan.

Petunjuk

Item yang akan diperiksa dengan pemeriksaan data bisa disetel.

Pilih [Tool] → [Data Check] → [Item Setting] dari menu bar.

Pilih item 
pemeriksaan.

1.5.2 Memeriksa Kesalahan Data (Pemeriksaan Data)
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1

(1) Menyiapkan program urutan
Siapkan program urutan untuk simulasi menggunakan simulator.
Untuk melanjutkan ke langkah berikutnya, buat program urutan menggunakan GX Works3.

<Contoh program>

(2) Memulai simulator untuk PLC
Mulai GX Simulator3 GX Works3.

Klik!

1

1 Pilih [Debug] → [Simulation] → [Start 
Simulation] dari menu bar GX Works3.

GX Simulator3 dimulai.

1.5.3 Memeriksa Operasi (Simulator)
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(3) Memulai simulator untuk GOT guna memeriksa layar yang dibuat
Mulai GT Simulator3 dari GT Designer3(GOT2000) untuk memeriksa layar yang dibuat.

Klik!

2

2 Pilih [Tools] → [Simulator] → [Set] menu bar GT 
Designer3(GOT2000).

Pilih 
“GX Simulator3”. 3

Klik!

4

3 Jika dialog yang ditunjukkan di kiri muncul, 
pilih GX Simulator3 untuk Connection.

4 Klik tombol [OK] untuk menyelesaikan 
pengaturan.

Klik!

5

5 Pilih [Tools] → [Simulator] → [Activate] dari 
menu bar GT Designer3(GOT2000).
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1
Simulator dimulai, dan layar yang dibuat bisa 
disimulasikan.

Lampu menyala 
dan nilai berubah 
menjadi 6666. 7

Klik!

6

6 Klik tombol RUN.

7 Lampu RUN menyala dan nilai Data 1 berubah 
menjadi 6666.

Petunjuk

Simulator bisa dimulai, diperbarui, dan dikeluarkan dari toolbar 

GT Designer3(GOT2000).
(1) (2) (3) (4)

(1) [Simulator: Activate]  Mengaktifkan GT Simulator3 untuk memulai simulasi.

(2) [Simulator: Update]   Memperbarui project dalam simulasi dengan project diedit. 
Perubahan yang dibuat menggunakan GT Designer3(GOT2000) bisa dicerminkan pada project 
dalam simulasi.

(3) [Simulator: Set]  Membuka jendela pengaturan simulator.

(4) [Simulator: End]  Keluar dari GT Simulator3.
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Lampu mati dan 
nilai berubah 
menjadi 3333. 9

Klik!

8

8 Klik tombol STOP.

9 Lampu RUN mati dan nilai Data 1 berubah 
menjadi 3333.

(4) Keluar dari simulator untuk GOT
Keluar dari GT Simulator3 setelah simulasi.

Klik!

10

10 Pilih [Tools] → [Simulator] → [Exit] dari menu 
bar GT Designer3(GOT2000).

(5) Keluar dari simulator untuk PLC
Keluar dari GX Simulator3 GX Works3.

Klik!

11

11 Pilih [Debug] → [Simulation] → [Stop 
Simulation] dari menu bar GX Works3.
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1

(1) Menyimpan layar yang dibuat

Klik!

1

1 Pilih [Project] → [Save As] dari menu bar.

Masukkan nama �le dan 
klik tombol Save.

2

2 Masukkan nama file dan klik tombol [Save] 
untuk menyimpan layar.

(2) Tipe file
Project dapat disimpan dalam format berikut.
• Format ruang kerja
• Format file tunggal (*.GTX)
• Format file tunggal (*.GTXS) dengan aplikasi sistem

Referensi

Dokumen ini menjelaskan format file tunggal (*.GTX) project.

Untuk detail tentang tiap format, baca bantuan atau GT Designer3(GOT2000) Screen Design Manual.

1.6 MENYIMPAN PROJECT
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MEMO



2-1

2

LANGKAH 2 

MENTRANSFER DATA PROJECT



2-2

Gunakan kabel USB untuk menyambungkan komputer pribadi ke GOT.

Sambungkan ke 
antarmuka USB

Komputer pribadi

GOT

Buka penutup depan dan 
sambungkan kabel ke 
antarmuka USB.

Kabel USB 
(GT09-C30USB-5P)

* Untuk komunikasi USB dengan GOT, instal driver USB.
Driver USB diinstal ke komputer pribadi pada sambungan pertama.
Data bisa juga ditransfer menggunakan kartu SD atau metode koneksi selain kabel USB.

Referensi

Untuk cara mentransfer data menggunakan kartu SD atau metode sambungan selain dari kabel USB, baca bantuan 

GT Designer3(GOT2000) Screen Design Manual.

2.1 MENTRANSFER DATA PROJECT
2.1.1 Menyambungkan komputer pribadi ke GOT
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2

Konfigurasi pengaturan komunikasi komputer pribadi dan GOT.
Nyalakan GOT sebelum konfigurasi.

Klik!

1
1 Pilih [Communication] → [Write to GOT] dari 

menu bar.

Klik!

3

Periksa bahwa “Connection to 
GOT: Direct” dan ”PC side I/F: 
USB” dipilih. 2

2 Periksa bahwa pengaturan berikut ini
sudah dikonfigurasi.
Connection to GOT: Direct 
PC side I/F: USB

Lakukan uji komunikasi untuk memeriksa 
komunikasi.

3 Klik tombol [Test].

Klik!

4

4 Ketika pesan [Successfully connected.] muncul, 
klik tombol [OK].

Klik!

5

5 Klik tombol [OK].

2.1.2 Pengaturan komunikasi
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Transfer data project dari komputer pribadi ke GOT.

Periksa Data “Write Data: Package Data” 
dan “Destination Drive: C:Built-in 
Flash Memory”. 6

Klik!

7

6 Periksa bahwa pengaturan berikut ini
sudah dikonfigurasi.
Write Data: Package Data
Destination Drive: C:Built-in Flash Memory

7 Klik tombol [GOT Write].

Klik!

8

Kotak dialog untuk mengonfirmasi penulisan ke 
GOT muncul.

8 Klik tombol [Yes] untuk mulai menulis.

Kotak dialog yang ditunjukkan di kiri ditampilkan 
saat data ditulis.
Jangan lakukan operasi berikut.
• Mematikan GOT
• Mencabut kabel
• Membuka penutup kartu SD

Klik!

9

9 Jika penulisan ke GOT sudah selesai, kotak 
dialog yang ditampilkan di kiri muncul. Klik 
tombol [OK].

2.1.3 Mentransfer data project
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2

GOT akan reboot otomatis.

10 Layar pemilihan bahasa muncul. Pilih [English].
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Sambungkan GOT dan PLC.
Sebelum menyambungkan GOT dan PLC periksa bahwa GOT dan PLC sudah dimatikan.

Setelah itu, sambungkan GOT dan PLC menggunakan kabel Ethernet, dan nyalakan GOT dan PLC.

Hubungkan ke antarmuka Ethernet 
di permukaan bagian belakang

GOT

PLC

Hubungkan ke antarmuka Ethernet 
di permukaan bagian depan

2.2 MENYAMBUNGKAN KE GOT DAN PLC
2.2.1 Menyambungkan GOT dan PLC
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2

Lakukan pemeriksaan status Ethernet GOT untuk memeriksa bahwa GOT bisa berkomunikasi dengan PLC.
Fungsi pemeriksaan status Ethernet memeriksa status koneksi antara GOT dan perangkat di jaringan Ethernet dengan 
mengirim permintaan ping.
Sebelum melakukan pemeriksaan status Ethernet, periksa bahwa GOT dan PLC sudah dinyalakan.

1

1 Sentuh tombol panggil utility di GOT untuk 
menampilkan menu utama utility.

Tombol panggil utility disetel di sudut kiri atas 
layar (tekan tombol selama 2 detik).
Pengaturan bisa diubah dengan GT    
Designer3(GOT2000).

Menu utama utility ditampilkan.

2.2.2 Memeriksa status koneksi
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2

2 Sentuh [Maintenance] → [Ethernet status 
check] di menu utama utility.

3

3 Setel alamat IP pengontrol target dan sentuh 
tombol [Ping transmission].

Dalam dokumen ini, alamat IP pengontrol 
target adalah 192.168.3.39 (default).
Alamat IP pengontrol target bisa diperiksa dan 
diubah di [Ethernet Setting] dengan memilih 
[Common] → [Controller Setting] dari menu 
bar GT Designer3(GOT2000).

4

5

Jika tidak ada kesalahan komunikasi, pesan 
[Response received.] muncul.

4 Sentuh tombol [OK].

5 Sentuh tombol [×] untuk menampilkan layar 
yang dibuat.
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2

Dengan program urutan, yang dibuat untuk simulasi, dari GX Works3 ke PLC.

2.2.3 Menulis program urutan ke PLC
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MEMO



3-1

3

LANGKAH 3 

MENGGUNAKAN GOT



3-2

Sentuh setiap sakelar untuk memeriksa tindakan sakelar.

(1) (2) (3)

(4)

Tampilkan layar yang dibuat.
Yang berikut ini menampilkan tindakan yang disetel untuk tiap objek.

(1) Sakelar RUN
Menyentuh sakelar ini memulai operasi (M0 dinyalakan).

(2) Sakelar STOP
Menyentuh sakelar ini menghentikan operasi (M1 dinyalakan).

(3) Lampu RUN
RUN: Lampu menyala dengan teks “RUN”. (Saat M0 menyala, Y10 menyala.)

(Y10 menyala menurut program urutan.)
STOP: Lampu mati dengan teks “STOP”. (Saat M1 menyala, Y10 mati.)

(Y10 mati menurut program urutan.)

(4) Data 1 (Tampilan numerik)
RUN: Nilai numerik 6666 ditampilkan. (Saat M0 menyala.)

(Nilai 6666 disimpan di D10 oleh program urutan.)
STOP: Nilai numerik 3333 ditampilkan. (Saat M1 menyala.)

(Nilai 3333 disimpan di D10 oleh program urutan.)

3.1 MEMERIKSA TINDAKAN ON/OFF SAKELAR
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3

1

1 Menyentuh sakelar RUN menyalakan Lampu 
RUN dan menampilkan 6666 di Data 1.

2

2 Menyentuh sakelar STOP mematikan Lampu 
RUN dan menampilkan 3333 di Data 1.
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Layar monitor bisa diperbesar dan diperkecil dengan menggunakan fungsi gerakan layar.

1

1 Sentuh sakelar untuk mengganti mode gerakan 
layar.

2

2 Garis merah yang mengindikasikan area yang 
bisa diperbesar dan diperkecil muncul.

3

3 Layar bisa diperbesar dan diperkecil dengan 
mencubit dan merenggangkan jari di dalam 
area ini.

3.2 MENGGUNAKAN FUNGSI GERAKAN LAYAR
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3

54

4 Untuk membatalkan mode gerakan layar, 
sentuh sakelar untuk mengganti mode gerakan 
layar.
Mode gerakan layar dibatalkan dan layar 
tampilan tetap diperbesar.

5 Untuk mengubah tampilan ke skala penuh, 
sentuh sakelar tampilan skala penuh 100%.
Jika tampilan layar diubah ke skala penuh 
selama mode gerakan layar, mode gerakan 
layar dibatalkan dan layar ditampilkan dalam 
skala penuh.
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3.3 DAFTAR FUNGSI GOT

GOT memiliki berbagai fungsi berguna. Bagian ini menguraikan beberapa fungsi tersebut.

Sentuh sakelar untuk mengubah nilai 
perangkat kata.

Sentuh sakelar untuk mengganti layar ke 
layar utility atau layar lain.

Sakelar kata Sakelar fungsi umum

Sentuh sakelar untuk mengganti layar dasar dan 
jendela.

Sakelar masuk ke layar

Sakelar tampilan key windows

Key windows yang ditentukan ditampilkan di 
posisi yang ditentukan, dan kursor ditampilkan di 
objek yang ditentukan.

Sentuh sakelar untuk mengaktifkan dan 
menonaktifkan perangkat bit.

Sakelar bit

Sentuh sakelar untuk mengganti nomor stasiun 
pengontrol yang akan dipantau.

Sakelar ubah no. Stasiun

Ubah target 
pemantauan.

Mengubah warna lampu.

Tampilan lampu

Sakelar kode utama

Layar dasar 1 Layar dasar 2

150 1500

Sakelar ini bisa digunakan sebagai tombol untuk 
memasukkan nilai numerik atau teks.

Lampu, sakelar

D100:

M0: ON → OFF

200 → 350
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Nilai ditulis ke perangkat.

Input numerik
Nilai perangkat ditampilkan dengan nilai numerik.

Tampilan numerik

334D100
45D100

Kode karakter dimasukkan ke perangkat.

A B C D

Input teks

Nilai perangkat ditampilkan dengan karakter.

MITSUBISHI

Tampilan teks

STOP

Tampilan komentar

Tampilan komentar ditampilkan.

RUN STOP

Tanggal dan waktu ditampilkan.

Tampilan jam

07/08/24

15:27

Tampilan teks, numerik

D100: 334 STOP
D100: 45

D10: 4241H (BA)
D11: 4443H (DC)

004D:
0049:
0054:
0053:
0055:
0042:
0049:
0053:
0048:
0049:

M
I
T
S
U
B
I
S
H
I

Suku cadang
Pergerakan suku cadangTam

Menampilkan suku cadang terdaftar. Menampilkan pergerakan suku cadang.

Bagian 1 Bagian 2
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Gra�s, penghitung * Hanya beberapa fungsi yang diperkenalkan di sini.

Tampilan gra�s tren statistik Tampilan gra�s tren historis

Tampilan levelTampilan penghitung panel

Kondisi → Operasi
Fungsi tindakan waktuFungsi pencatatan

Nilai perangkat ditampilkan dengan penghitung.

Beberapa nilai perangkat ditampilkan 
dalam gra�s dengan persentase total.

Nilai perangkat ditampilkan dengan 
persentase total.

Gra�k pai Gra�k batang

Data mencakup data masa lalu dan sekarang yang 
dikumpulkan menggunakan fungsi pencatatan 
yang ditampilkan dengan gra�s tren.

Nilai perangkat dikumpul dan disimpan. Perangkat bisa ditulis pada tanggal 
dan waktu yang ditentukan.

ResepSlider
Fungsi resepSlider

Status perangkat dipantau, dan nilai perangkat 
dibaca atau ditulis jika kondisi terpenuhi. 
Beberapa nilai dapat disetel ke satu perangkat. 
Nilai perangkat bisa dibaca atau ditulis 
menggunakan utility.

Gunakan slider untuk menyetel nilai kontinu 
pada perangkat dalam rentang pengaturan apa 
pun. Nilai tujuan tempat Anda menyetop kenop 
adalah input ke perangkat.

Baca/
Tulis

Mengubah output yang 
disetel dengan slider

* Hanya beberapa fungsi yang diperkenalkan di sini.

→  

D100:
D101:
D102:

150 250
500300 
235208

Production line
Current output
Set output

Production line
Current output
Set output
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Lainnya

Monitor perangkat Backup/Pulihkan

Peralihan bahasaTampilan dokumen

Memantau status perangkat PLC. Pengaturan pengontrol bisa dibackup 
atau dipulihkan dari GOT.

Beberapa bahasa bisa dialihkan 
untuk menampilkan yang tepat.

Data dokumen dapat ditampilkan di GOT.

backup

Pulihkan

* Hanya beberapa fungsi yang diperkenalkan di sini.

English

Hello

M10  ●
M20  ○
D100  255

M10   ON
M20  OFF
D100 255

I/O eksternal * Hanya beberapa fungsi yang diperkenalkan di sini.

Barcode Panel operasi

Tampilan videoLaporan

Data yang dibaca dengan pembaca barcode 
ditulis ke perangkat.

Perangkat yang ditulis dengan mengoperasikan 
panel pengoperasian.

Mengumpulkan data seperti manajemen 
produksi dan status produksi dan 
mencetak data yang dikumpulkan.

Menampilkan gambar video.

150



3-10

3.4 Fungsi yang Mudah untuk Pemeliharaan

Alarm

Tampilan alarm sederhana Tampilan alarm sistem

Tampilan popup alarmTampilan alarm

Menampilkan kesalahan GOT, kesalahan 
komunikasi, pesan yang dibuat oleh pengguna 
sebagai riwayat saat alarm bunyi. 
Alarm ditampilkan secara hierarkis.

Menampilkan kesalahan GOT, kesalahan 
komunikasi, pesan yang dibuat oleh pengguna 
dengan jendela pop-up saat alarm bunyi.

Menampilkan pesan yang dibuat pengguna 
saat alarm bunyi.

Menampilkan kesalahan GOT dan kesalahan 
komunikasi saat alarm bunyi.

13:25 Line A stop

13:25 Line A stop
13:05 Upper limit over
13:03 Motor trip

Time  Message

02/04/18  13:25:40
Line stop

307 No monitor device 
is set.

Fungsi GOT Mobile
Fungsi ini memantau peralatan tersambung melalui GOT dari perangkat informasi seperti komputer pribadi, 
tablet, dan smartphone.
Pengguna bisa dengan mudah mengetahui status peralatan di lokasi lokal dari tempat yang jauh.
Lima perangkat informasi dapat mengakses satu unit GOT pada saat bersamaan.

2 3

41 5

Smartphone TabletTabletGOT

PCPC dan layar monitor besar

Lokasi
produksi

Kantor
Lokasi jarak jauh atau kantor
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Fungsi penampil log

Date and time

2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00

150
152
158
170

Line 1
100
98
95
92

Line 2
250
260
270
280

Line 3

Date and time
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00

150
152
158
170

Line 1
100
98
95
92

Line 2
250
260
270
280

Line 3

Date and time
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00

150
152
158
170

Line 1
100
98
95
92

Line 2
250
260
270
280

Line 3

Date and time
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00

150
152
158
170

Line 1
100
98
95
92

Line 2
250
260
270
280

Line 3

Meski komputer pribadi tidak diinstal di lokasi lokal, GOT bisa mendapatkan (pencatatan) dan menampilkan 
data dalam peralatan tersambung seperti pengontrol yang dapat diprogram menggunakan fungsi ini 
sehingga tindakan cepat dapat diambil terhadap masalah yang terjadi di lokasi lokal.

Fungsi informasi log operasi
Fungsi ini menyimpan operasi yang dilakukan oleh pengguna ke GOT dalam penyimpanan data sebagai 
log operasi. Operasi yang disimpan dalam log dapat digunakan dalam penyelidikan pergerakan yang 
dilakukan jika terjadi masalah di lokasi produksi.

Daftar Data Log Operasi

Mengon�rmasi kerangka log

Informasi Detail

Mengon�rmasi detail log

Akuisisi data pencatatan Penyimpanan data

Data pencatatan Data pencatatan
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Contoh layar
Berbagai layar dideretkan untuk menampilkan fungsi yang sering digunakan di lokasi lokal.
Dengan merujuk pada contoh layar, pengguna tidak harus membuat layar serupa dari awal.
Jika Anda memerlukan contoh layar, hubungi kantor cabang atau perwakilan Mitsubishi setempat Anda.

Tampilan Gra�k Tren Tampilan Penghtung Pengaturan Parameter

Manual_Pengoperasian Tampilan_Alarm_Saat Ini

Kata sandi
Otoritas untuk mengoperasikan dan menjelajahi GOT bisa disetel dengan mengatur nama operator dan 
kata sandi untuk tiap pengguna.
Mengatur kata sandi mewujudkan “peningkatan keamanan” dan ”kontrol akses untuk tiap pengguna”.
Dengan memadukan kata sandi dan fungsi informasi log pengoperasian, memungkinkan untuk memeriksa 
“siapa (orang), kapan (tanggal dan waktu), apa (data target), dan bagaimana (metode)” tiap operasi yang 
dilakukan.

Login 
diizinkan

Operator A 
memiliki otoritas 

operasi

Operator B 
tidak memiliki 
otoritas operasi

Login 
tidak diizinkan
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4

LANGKAH 4 

PEMELIHARAAN GOT
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Peralatan FA dapat bertahan di berbagai lingkungan, termasuk perubahan suhu dan getaran, dan berfungsi sebagai 
kekuatan penggerak utama di lokasi produksi.
Namun, peralatan FA adalah perangkat elektronik yang presisi, dan dapat tiba-tiba mengalami kerusakan. Khususnya, 
GOT yang dipasang di permukaan panel kontrol dapat dengan mudah terkena dampak tekanan eksternal. 
Jika kerusakan peralatan FA berlanjut untuk waktu yang lama, produktivitas dapat menurun pesat. Penting untuk 
memulihkan kerusakan peralatan FA sesegera mungkin.
Periode waktu di mana peralatan berhenti karena adanya kerusakan disebut sebagai “waktu tidak dapat beroperasi 
(down time)”.
Bab 4 menjelaskan tiga pemeliharaan dasar berikut yang diperlukan untuk mempertahankan status normal GOT:

1. Backup
2. Alarm
3. Baterai

4.1 PERLUNYA BACKUP
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Data GOT dan data perangkat yang tersambung dapat dibackup.
Untuk membackup data, gunakan fungsi utility GOT.
Fungsi utility didesain untuk menyambungkan GOT dan berbagai perangkat, menyetel data di layar, menyetel prosedur 
operasi, mengelola program/data, dan menjalankan diagnosis sendiri.

Sebelum membackup
Untuk membackup, perlu menginstal aplikasi sistem (fungsi tambahan) di drive C GOT (memori flash bawaan).
(1) Menginstal aplikasi sistem (fungsi tambahan)

Sebelum menginstal aplikasi sistem (fungsi 
tambahan), lakukan pengaturan berikut.
→  2.1.1 Menyambungkan komputer pribadi ke GOT
→ 2.1.2 Pengaturan komunikasi

Klik!

1

1 Klik tombol [Write Option].

Dialog [Write Option] akan ditampilkan.

Klik!

2

2 Klik tombol [Application Selection].

4.2 PEMELIHARAAN
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Dialog [Application Selection] akan  
ditampilkan.

3

4

Klik!

Klik!

3

4

Centang [Backup/Restoration].

Klik tombol [OK].

Klik!

5

5 Klik tombol [GOT Write], dan penulisan akan 
dimulai.
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Membackup artinya membuat salinan data.
Jika ada perangkat yang rusak dan harus diganti dengan yang baru, data dalam perangkat tersebut bisa dipulihkan dari 
salinan backup.
Untuk GOT, ada dua metode backup, satu dengan menyambungkan ke komputer pribadi dan satu lagi dengan 
menggunakan kartu SD.
Kali ini, dengan asumsi komputer pribadi tidak tersedia atau tidak bisa dibawa ke lokasi, prosedur untuk membackup ke 
kartu SD dijelaskan.

Fungsi akuisisi paket data (backup) GOT
Untuk membackup data yang ada di GOT, unit utama, gunakan fungsi akuisisi paket data GOT.
Fungsi akuisisi paket data GOT didesain untuk menyalin semua data yang ada di unit utama GOT ke kartu SD. (Akusisi 
paket data GOT)
Data yang disalin dapat ditempatkan di GOT lain untuk membuat sistem GOT yang sama. (Penempatan data GOT)

Alur Kerja

GOT GOT

Kartu SD

Instalasi data GOT
(Pemulihan)

Akuisisi paket data GOT 
(Backup)

4.2.1 Membackup data GOT
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(1) Prosedur akuisisi paket data (backup) GOT

1

1 Sentuh [Utility call key].

2

2 Sentuh [Backup Restoration] di layar [Data 
mng.] di [Utility main menu].

3

3 Sentuh [GOT data package acquisition (GOT 
data)].
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4

4

5

4

5

Menyentuh nama drive di bawah ini [Select 
Drive] membalikkan nama drive.

Menyentuh tombol [Copy] memulai 
penyalinan.

Setelah menyalin aplikasi dan data sistem, kotak 
dialog untuk memberi tahu penyelesaian muncul.

6

6 Menyentuh tombol [OK] menutup kotak dialog.

Dengan begitu, akuisisi paket data (backup) GOT 
selesai.
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(2) Prosedur menempatkan (memulihkan) data GOT

Sakelar instalasi
(S.MODE)

2

1

2

Matikan daya ke GOT, dan masukkan kartu SD 
yang berisi data ke antarmuka kartu SD GOT.
Untuk informasi prosedur memasukkan 
kartu SD, lihat bagian berikut ini. (Halaman 
LAMPIRAN 2-9 dalam teks ini)
→  LAMPIRAN 2-7 Memasukkan/Melepaskan 

Kartu SD

Nyalakan GOT sambil menekan sakelar pasang 
(S.MODE switch) di bagian belakang GOT.

Do you want to execute installation?

O  K Batal3

3 Sentuh [OK]. Data akan ditempatkan ke memori 
flash bawaan.

Install now…
4 LED akses kartu SD menyala selama 

menjalankan penempatan ini.
Jangan tarik kartu SD atau MATIKAN GOT 
selama LED akses kartu SD menyala.
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Installation has been completed.

O  K 5

5 Sentuh [OK]. GOT akan reboot otomatis.

6 Setelah mengonfirmasi penyalaan ulang 
normal, konfirmasi bahwa LED akses kartu SD 
tidak menyala, dan lepaskan kartu SD
dari antarmuka kartu SD GOT.
Untuk informasi prosedur melepaskan kartu SD, 
lihat bagian berikut ini. (Halaman LAMPIRAN 
2-9 dalam teks ini)
→  LAMPIRAN 2-7 Memasukkan/Melepaskan 

Kartu SD

Dengan demikian, penempatan data GOT 
(pemulihan) selesai.
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Data pengaturan, termasuk program urutan, parameter, dan nilai pengaturan, untuk pengontrol yang tersambung ke 
GOT bisa disimpan (dibackup) dalam kartu memori USB di GOT.
Dengan backup data untuk pengontrol, data bisa dipulihkan ke pengontrol dengan GOT tersambung ke pengontrol 
meski pengontrol harus diganti karena adanya masalah, termasuk kerusakan. Sebagai hasilnya, sistem bisa dengan 
mudah dipulihkan.

Fungsi backup (Device→GOT)
Fungsi backup digunakan untuk menyalin data dalam perangkat yang tersambung ke GOT ke dalam kartu SD.

Fungsi pemulihan (GOT→Device)
Fungsi pemulihan digunakan untuk mengembalikan data perangkat yang disimpan di kartu SD ke perangkat.

Alur Kerja

GOT

Perangkat

Membackup data pengaturan 
ke kartu SD

Pulihkan data backup
ke pengontrol.

Kartu SD

4.2.2 Membackup data di perangkat tersambung
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(1) Menyetel tujuan untuk menyimpan data backup

1

1 Sentuh [Utility call key].

2

2 Sentuh [Backup Restoration] di layar [Ext. func. 
set] di [Utility main menu].

3

4

3 Jika item penyetelan disentuh, konten 
penyetelan diubah.
Setel “Drive for backup data” menjadi [A: Built-in 
SD card].

4 Jika tombol [OK] di sentuh, maka akan kembali 
ke halaman sebelumnya, pengaturan yang 
diubah dicerminkan dan layar kembali ke layar 
[Ext. func. set] .
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(2) Mengoperasikan fungsi backup (Device→GOT)

1

1 Sentuh [Utility call key].

2

2 Sentuh [Backup restoration] di layar [Data 
mng.] di [Utility main menu].

3

3 Sentuh [Backup function (Device→GOT)].
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4

4

4 Jendela yang ditunjukkan di sebelah kiri akan 
ditampilkan. Sentuh tombol [OK].

“Backing up” berkedip-kedip di kolom Status.

5 Backup data dalam perangkat tersambung 
akan dimulai.

6

Setelah menyelesaikan backup data pada perangkat 
tersambung, kotak dialog penyelesaian akan 
ditampilkan.

6 Sentuh tombol [OK].

7

“Completed” akan ditampilkan di kolom Status.

7 Sentuh tombol [Close].

Lalu, backup (Device→GOT) selesai.
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(3)  Mengoperasikan fungsi pemulihan (GOT→Device)

1

1 Sentuh [Utility call key].

2

2 Sentuh [Backup restoration] di layar [Data 
mng.] di [Utility main menu].

3

3 Sentuh [Restoration function (GOT→Device)].
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4 5

6

Data backup yang disimpan di kartu SD akan 
ditampilkan dalam formulir daftar.

4

5

6

Pilih data backup yang akan dipulihkan dengan 
menyentuh data.

Sentuh nama unit (perangkat tersambung 
tempat data akan dikembalikan).

Sentuh tombol [Execute].

7

7 Jendela yang ditunjukkan di sebelah kiri akan 
ditampilkan. Sentuh tombol [OK].

8

Dengan demikian, jendela yang ditunjukkan di kiri 
akan ditampilkan. Memungkinkan untuk memilih 
apakah akan menyimpan informasi di register file 
di PLC atau tidak. Untuk informasi detail tentang 
register file, lihat manual untuk PLC yang akan 
digunakan.

8 Sentuh tombol [Yes].

“Restoring” akan ditampilkan di kolom Status.

9 Pemulihan data dalam perangkat tersambung 
akan dimulai.
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10

Setelah penyelesaian pemulihan data pada 
perangkat tersambung, kotak dialog penyelesaian 
akan ditampilkan.

10 Sentuh tombol [OK].

11

“Completed” akan ditampilkan di kolom Status.

11 Sentuh tombol [Close].

Dengan demikian, pemulihan (GOT→Device) selesai.
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Perangkat tersambung tempat data akan dibackup/dipulihkan.
Untuk pengaturan tipe koneksi dan petunjuk keselamatan tentang unit/kabel komunikasi dan tipe koneksi, baca yang 
berikut ini.
→GOT2000 Series Connection Manual (Mitsubishi Products) For GT Works3 Version1
→GOT2000 Series User’s Manual (Monitor)

Pengontrol Model

RCPU R04CPU, R08CPU, R16CPU, R32CPU, R120CPU

Motion Controller CPU (Seri MELSEC iQ-R) R16MTCPU, R32MTCPU

QCPU (mode Q) Model dasar Q00JCPU, Q00CPU, Q01CPU

Model berkinerja tinggi Q02CPU, Q02HCPU, Q06HCPU, Q12HCPU, Q25HCPU, Q02PHCPU, 
Q06PHCPU, Q12PHCPU, Q25PHCPU

Model universal Q00UJCPU, Q00UCPU, Q01UCPU, Q02UCPU, Q03UDCPU, 
Q04UDHCPU, Q06UDHCPU, Q10UDHCPU, Q13UDHCPU, 
Q20UDHCPU, Q26UDHCPU, Q03UDECPU, Q04UDEHCPU, 
Q06UDEHCPU, Q10UDEHCPU, Q13UDEHCPU, Q20UDEHCPU, 
Q26UDEHCPU, Q50UDEHCPU, Q100UDEHCPU, Q03UDVCPU, 
Q04UDVCPU, Q06UDVCPU, Q13UDVCPU, Q26UDVCPU

Motion Controller CPU (Seri Q) Q172CPU, Q173CPU, Q172HCPU, Q173HCPU, Q172DCPU, 
Q172DCPU-S1, Q173DCPU, Q173DCPU-S1, Q172DSCPU, 
Q173DSCPU, Q170MCPU, Q170MCPU-S1, Q170MSCPU, 
Q170MSCPU-S1

LCPU L02CPU, L06CPU, L26CPU, L26CPU-BT, L26CPU-PBT, L02CPU-P, 
L02SCPU

FXCPU FX0, FX0S, FX0N, FX1, FX2, FX2C, FX1S, FX1N, FX1NC, FX2N, FX2NC, FX3U, 
FX3UC, FX3G

CNC C80 R16NCCPU

CNC C70 Q173NCCPU

Seri MELSERVO-J4 MR-J4-GF

Seri FREQROL-A Seri REQROL-A800, seri FREQROL-A800 Plus

Robot Controller CRnQ-700, CR750-Q, CR751-Q, CRnD-700, CR750-D, CR751-D
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(1) Tipe alarm
GOT memiliki dua jenis fungsi alarm.

(a) Alarm sistem
Fungsi ini menampilkan kode kesalahan dan pesan kesalahan jika terjadi kesalahan pada GOT dan perangkat 
tersambung maupun jaringan.

Kesalahan
terjadi

400 The communication 

with CPU failed. 16:40:30

9  AC down has been detected.

803 The transient error has occurred.

(b) Alarm pengguna
Fungsi ini menampilkan komentar yang dibuat oleh pengguna sebagai pesan alarm jika terjadi alarm.
Gunakan fungsi ini saat menampilkan alarm yang dibuat oleh pengguna.
Untuk informasi detail tentang alarm pengguna, lihat manual berikut.
→GT Designer3(GOT2000) Screen Design Manual

M100: OFF → ON
M101: OFF → ON

Error date and time Comment

Jun. 1, 2013 Fuse error

Jun. 1, 2013 Oil error

Jun. 1, 2013 Temperature anomaly

Detail

Touch

Error date and time Comment

May 1, 2004 Fuse error

May 1, 2004 Oil error

May 1, 2004 Temperature anomaly

Detail

Replace the fuse of 

the power supply unit.

4.3 ALARM
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4.3.1 Memeriksa alarm sistem

(1) Prosedur untuk memeriksa alarm sistem

1

1 Sentuh [Utility call key].

2

2 Sentuh [System alarm] di layar [Maintenance] 
di [Utility main menu].

Kode Kesalahan
Pesan Kesalahan

Jendela alarm sistem akan ditampilkan.
Untuk alarm sistem, baca yang berikut: 
(Halaman LAMPIRAN 1-1 dalam teks ini)
→  LAMPIRAN 1 KODE KESALAHAN DAN 

DAFTAR ALARM SISTEM
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(2) Mereset tampilan alarm sistem
1 Hilangkan setiap penyebab terjadinya alarm 

sistem.
Penyebab berupa kesalahan dapat diidentifikasi 
dengan kode kesalahan, pesan kesalahan, dan 
No. saluran yang ditampilkan di layar alarm 
Sistem.
→  LAMPIRAN 1 KODE KESALAHAN DAN 

DAFTAR ALARM SISTEM

2

2 Sentuh tombol [Reset] untuk mereset alarm.
Namun, jika penyebab alarm sistem belum 
diatasi, tampilan alarm sistem tidak akan direset 
sekalipun operasi reset dilakukan. Periksa ulang 
sistem.
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4

Baterai digunakan untuk menyimpan data SRAM, data jam, dan data backup data log status sistem.
Penggantian baterai secara berkala dianjurkan.
Untuk informasi detail tentang penampilan status baterai, baca yang berikut. (Halaman 4-28 dalam teks ini)
→ 4.4.3 Memeriksa voltase baterai

Pasang baterai ke GOT sebelum penyalaan pertama.
Prosedur untuk memasang dan melepaskan baterai sebagai contoh pada GT27 ditunjukkan di bawah ini. (Sisi belakang 
GOT menghadap ke atas dalam gambar.)

Poin

(1) Baterai

GT27 dilengkapi dengan sebuah baterai di tempat baterai. Sebelum menggunakan GT27, sambungkan konektor 

baterai ke konektor GOT.

 

(2) waktu penggantian baterai

Untuk mengganti baterai, biarkan GOT selama lebih dari 10 menit sebelum mengganti baterai. Ganti baterai dalam 5 

menit.

Prosedur memasang baterai berbeda bergantung pada model GOT.

 ● GT2715, GT2712, GT2710
Yang berikut ini menunjukkan prosedur pemasangan baterai, dengan mengambil GT2712 sebagai contoh.

1 Pastikan daya GOT dimatikan.

Penutup baterai 2 Pasang baterai ke permukaan belakang GOT.
Buka penutup baterai seperti ditunjukkan di 
kiri.

3 Untuk mengganti baterai, lepaskan baterai 
lama lalu putuskan sambungan konektor.

4.4 BATERAI
4.4.1 Memasang Baterai
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 ● Tanpa kabel sambung baterai

Penutup baterai

Tanpa kabel sambung baterai

Baterai Konektor

Kabel hitam

Kabel merah

4 Konektor sisi GOT bergantung pada apakah 
GOT memiliki kabel sambung baterai.
•  Tanpa kabel sambung baterai 

Masukkan konektor baterai ke konektor GOT.
•  Dengan kabel sambung baterai 

Masukkan konektor baterai ke konektor kabel 
sambung baterai GOT.

Model GT27 dengan versi hardware berikut 
tidak memiliki kabel sambung baterai.
•  GT2715: Versi G atau yang lebih baru 

(diproduksi bulan September 2014)
•  GT2712: Versi M atau yang lebih baru 

(diproduksi bulan September 2014)
•  GT2710: Versi N atau yang lebih baru 

(diproduksi bulan September 2014)

 ● Dengan kabel sambung baterai

Penutup bateraiKabel sambung baterai

Baterai

Kabel hitam

Kabel merah

Kabel merah

Konektor

Kabel hitam

Penutup bateraiBaterai

Konektor

5 Setelah memasang baterai ke tempat baterai 
GOT, tutup penutup baterai hingga terdengar 
suara klik.
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4

6 Nyalakan GOT.

7 Periksa bahwa kondisi baterai normal 
menggunakan utility.
Untuk informasi detail tentang penampilan 
kondisi baterai, baca yang berikut. (Halaman 
4-28 dalam teks ini)
→ 4.4.3 Memeriksa voltase baterai

 ● GT2708, GT2705

Yang berikut ini menunjukkan prosedur pemasangan baterai, 
dengan mengambil GT2708 sebagai contoh.

1 Pastikan daya GOT dimatikan.

Penutup kartu SD 2 Pasang baterai di dalam penutup kartu SD di 
sisi GOT.
Buka penutup kartu SD seperti ditunjukkan di 
kiri.

3 Lepaskan baterai lama lalu putuskan 
sambungan konektor.
Untuk informasi tentang cara melepaskan 
baterai, baca yang berikut.

Penutup kartu SD

Baterai

Konektor

Kabel hitam

Kabel merah

4 Masukkan konektor baterai ke konektor GOT.



4-24

Penutup kartu SDBaterai

Konektor

5 Setelah memasang baterai ke tempat baterai 
GOT, tutup penutup kartu SD hingga terdengar 
suara klik.

6

7

Nyalakan GOT.

Periksa bahwa kondisi baterai normal 
menggunakan utility.
Untuk informasi detail tentang penampilan 
kondisi baterai, baca yang berikut. (Halaman 
4-28 dalam teks ini)
→ 4.4.3 Memeriksa voltase baterai
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4

Prosedur melepaskan baterai berbeda bergantung pada model GOT.

 ● GT2715, GT2712, GT2710
Yang berikut ini menunjukkan prosedur pelepasan baterai, dengan mengambil GT2712 sebagai contoh.

1 Pastikan daya GOT dimatikan.

Penutup bateraiBaterai

Konektor

2 Baterai disimpan di permukaan belakang GOT.
Buka penutup baterai seperti ditunjukkan di 
kiri.

 ● Tanpa kabel sambung baterai

Penutup baterai

KonektorBaterai

Kabel hitam

Kabel merah

3 Setelah melepaskan baterai dari tempat baterai 
GOT, cabut konektor.
Konektor sisi GOT bergantung pada apakah 
GOT memiliki kabel sambung baterai.
•  Tanpa kabel sambung baterai 

Cabut konektor baterai dari konektor GOT.
•  Dengan kabel sambung baterai 

Cabut konektor baterai dari kabel sambung 
baterai GOT.

Model GT27 dengan versi hardware berikut 
tidak memiliki kabel sambung baterai.
•  GT2715: Versi G atau yang lebih baru 

(diproduksi bulan September 2014)
•  GT2712: Versi M atau yang lebih baru 

(diproduksi bulan September 2014)
•  GT2710: Versi N atau yang lebih baru 

(diproduksi bulan September 2014)

4.4.2 Melepaskan Baterai
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 ● Dengan kabel sambung baterai

Penutup bateraiKabel sambung baterai

Baterai

Kabel hitam

Kabel merah

Kabel merah

Konektor

Kabel hitam

Penutup baterai 4 Tekan dan tutup penutup baterai hingga 
terdengar suara klik.
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4

 ● GT2708, GT2705
Yang berikut ini menunjukkan prosedur pelepasan baterai, dengan mengambil GT2708 sebagai contoh.

1 Pastikan daya GOT dimatikan.

Penutup kartu SDBaterai

Konektor

2 Baterai disimpan di dalam penutup kartu SD di 
sisi GOT.
Buka penutup kartu SD seperti ditunjukkan di 
kiri.

Penutup kartu SD

Baterai

Konektor

Kabel hitam

Kabel merah

3 Setelah melepaskan baterai dari tempat baterai 
GOT, cabut konektor baterai dari konektor GOT.

Penutup kartu SD 4 Tutup penutup kartu SD hingga terdengar 
suara klik.
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Voltase baterai dapat diperiksa dengan dua metode.
● Memeriksa menu utility
● Memeriksa layar alarm sistem

(1) Metode untuk memeriksa di menu utility

1

1 Sentuh [Utility call key].

2

2 Sentuh layar [Time] on the [GOT basic set] di 
[Utility main menu].

Menampilkan status voltase baterai.

Tampilan Status

Normal Normal

Low/None Voltase turun atau tidak ada baterai 

yang terpasang

Jika voltase baterai rendah, segera ganti 
baterai.
GOT menyimpan data selama 14 hari setelah 
deteksi voltase baterai rendah. Namun, setelah 
periode tersebut, GOT tidak bisa menyimpan 
data itu.

4.4.3 Memeriksa voltase baterai
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4

(2) Metode penyetelan untuk menampilkan di layar alarm sistem

1

1 Sentuh [Utility call key].

2

2 Sentuh [Display] di layar [GOT basic set] di 
[Utility main menu].

3

4

3 Sentuh [Battery alarm display], dan pengaturan 
akan berubah. (ON ⇔ OFF) 
Setel ke [ON].

4 Sentuh tombol [OK] untuk menyalakan 
ulang GOT dan mencerminkan perubahan 
pengaturan.
Untuk membatalkan perubahan pengaturan 
pada menu utama, sentuh tombol [Cancel].
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 ● Memeriksa layar alarm sistem

Jika voltase baterai turun terdeteksi, jendela 
yang ditunjukkan di kiri akan ditampilkan.
Segera ganti baterai.
GOT menyimpan data selama 14 hari setelah 
deteksi voltase baterai rendah. Namun, setelah 
periode tersebut, GOT tidak bisa menyimpan 
data itu.



LAMPIRAN 1-1

LAMPIRAN

LAMPIRAN 1 KODE KESALAHAN DAN DAFTAR 

ALARM SISTEM
(1) Kode kesalahan yang ditampilkan di GOT

Kode 
kesalahan

Sumber 
kesalahan

Deskripsi

300 hingga 399

GOT

Kode kesalahan fungsi unit utama GOT

400 hingga 499 Kode kesalahan fungsi komunikasi GOT

500 hingga 699 Kode kesalahan fungsi unit utama GOT

800 hingga 999 Jaringan Kode kesalahan jaringan

(2) Daftar alarm sistem

Kode 
kesalahan

Pesan kesalahan Tindakan

300
Project data contains 
unsupported objects.

Instal GT Designer3 versi terbaru dan tulis data lagi data paket ke GOT.

301
Project data contains 
unsupported functions.

Instal GT Designer3 versi terbaru dan tulis data lagi data paket ke GOT.

302
Project data contains 
unsupported settings.

Instal GT Designer3 versi terbaru dan tulis data lagi data paket ke GOT.

303
Set monitor points too large. 
Decrease setting points.

Kurangi jumlah objek dari layar yang ditampilkan. Untuk jumlah 
maksimum objek untuk 1 layar, baca yang berikut.
→ GT Designer3(GOT2000) Screen Design Manual

305
Background loading of the 
system package failed.

Periksa bahwa penyimpanan data, yang menyimpan data paket dan 
data project GOT sudah terinstal dan data tidak rusak.

306
No project data. Download 
screen data.

Data project tidak diunduh atau data layar tidak memadai.
Unduh data project atau data layar.

307 Monitor device not set
Perangkat monitor objek tidak disetel.
Setel perangkat monitor objek.

308
No comment data. Download 
comment.

File komentar tidak ada.
Buat file komentar dan unduh ke GOT.

309
Device reading error. Correct 
device.

Kesalahan terjadi saat membaca perangkat yang kontinu.
Koreksi perangkat.

310
Project data does not exist or 
out of range.

Layar dasar/layar jendela yang ditetapkan tidak ada dalam data project.
Layar dasar/layar jendela di luar area yang di luar area yang diizinkan. 
Tentukan layar dasar / layar jendela yang ada.

311
No. of alarm has exceeded 
upper limit. Delete restored 
alarm.

Jumlah riwayat alarm yang bisa diamati oleh fungsi tampilan riwayat 
alarm telah melebihi poin maksimum.
Hapus riwayat yang dipulihkan untuk mengurangi jumlah riwayat 
alarm.

LAMPIRAN 
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Kode 
kesalahan

Pesan kesalahan Tindakan

312
No. of sampling has exceeded 
upper limit. Delete collected 
data.

Frekuensi pengumpulan melebihi batas atas jika “Store Memory” dan 
“Accumulate/Average” disetel dalam grafik pencar.
•  Setujui penyetelan “Clear trigger” dalam grafik pencar.
•  Setel “Operation at frequency over time” ke “Initialize and Continue” 

dalam grafik pencar.

315
Device writing error. Correct 
device.

Kesalahan terjadi saat menulis dalam perangkat.; Koreksi perangkat.

316
Cannot display or input 
operation value. Review 
expression.

Dalam spesifikasi komentar/nomor suku cadang tidak langsung, 
hasil operasi data melebihi rentang di mana tipe perangkat dapat 
dinyatakan.
Tinjau ekspresi operasional data agar tidak melebihi rentang di mana 
tipe perangkat dapat dinyatakan.

317
Too high frequency of data 
collection.
Review conditions.

Data sebuah objek, yang untuknya [Collect data only when trigger 
conditions are satisfied] disetel, dikumpulkan terlalu sering, atau jumlah 
objek telah melebihi jumlah objek yang dapat dikumpulkan secara 
bersamaan.
• Setel siklus yang lebih panjang untuk kejadian pemicu untuk setiap 
objek.
•  Buat pengaturan sehingga ada 257 atau lebih pemicu tampilan objek, 

yang untuknya [Collect data only when trigger conditions are satisfied] 
disetel, jangan terjadi secara bersamaan.

320
Specified object does not exist 
or out of range.

File suku cadang tidak ada.
Buat file suku cadang dan unduh ke GOT.

322
Dedicated device is out of 
range.
Confirm device range.

No. perangkat yang dipantau di luar area CPU PLC target yang diizinkan.
Setel perangkat dalam rentang yang dapat dipantau oleh CPU PLC yang 
dipantau dan pengaturan parameter.

326
Label data types do not match.
Confirm the label setting.

•  Tipe data perangkat yang dipilih untuk label tidak tepat. 
Untuk tipe data label global yang tersedia, baca yang berikut. 
→ GT Designer3(GOT2000) Screen Design Manual

•  Tipe data perangkat objek atau yang lainnya dan tipe data label yang 
ditetapkan di sisi PLC tidak konsisten. 
Koreksi tipe data objek atau yang lainnya sesuai dengan tipe data label 
yang disetel pada sisi PLC.

•  Nilai konstanta disetel untuk label.;Dalam pengaturan objek, jangan 
gunakan label yang nilai konstantanya disetel.

•  Perangkat tipe 64-bit dipilih untuk label. 
Jangan gunakan label tipe 64-bit dalam pengaturan perangkat.

327
Label names have not been 
resolved. Resolve label names 
again.

Periksa status koneksi PLC dan jalankan lagi resolusi nama label.
→ GT Designer3(GOT2000) Screen Design Manual
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LAMPIRAN

Kode 
kesalahan

Pesan kesalahan Tindakan

328
Label setting error. Confirm the 
label setting.

•  Label ditetapkan untuk PLC yang tidak mendukung label. 
Koreksi No. jaringan dan nomor stasiun.

•  Nama label yang ditetapkan dalam data project tidak ada di sisi PLC. 
Periksa apakah nama label yang ditetapkan dalam data project ada di 
sisi PLC.

•  GOT mengakses ke label tidak dapat diakses dari perangkat eksternal. 
Aktifkan akses dari perangkat eksternal dalam pengaturan label di sisi 
PLC.

•  Jika struktur label global memiliki anggota yang padanya perangkat 
ditetapkan secara manual, GOT gagal menjalankan resolusi nama. 
Jalankan operasi agar perangkat otomatis ditetapkan ke anggota, 
atau langsung setel perangkat yang ditetapkan secara manual sebagai 
perangkat monitor.

329
Station No. switching does not 
support labels.

Jangan lakukan peralihan no. stasiun ke stasiun menggunakan label.

330
Insufficient memory media 
capacity.
Confirm M-card capacity.

Ruang yang tersedia di kartu memori tidak mencukupi.
Periksa ruang yang tersedia di kartu memori.; Untuk metode 
pemeriksaan, baca yang berikut ini.
→ GT Designer3(GOT2000) Screen Design Manual

331
Memory card not installed or 
MCARD switched OFF.

Kartu memori tidak terinstal di drive, atau penutup kartu SD terbuka.
• Pasang kartu memori di drive yang ditentukan.
• Tutup penutup kartu SD agar kartu SD dapat diakses.

332
Memory media is not 
formatted.

Kartu memori (kartu SD bawaan) tidak diformat atau diformat dengan 
tidak benar.
Format kartu memori.

333
Unable to overwrite. Memory 
card is write-protected.

Kartu memori (kartu SD bawaan) tak dapat ditulisi.
Batalkan perlindungan tulis kartu memori tersebut.

334
Memory media error. Replace 
memory media.

Kartu memori (kartu SD bawaan) rusak.
Ganti kartu memori.

336
The target file size is too large 
to be accessed.

•  Periksa apakah ukuran file yang coba diakses GOT lebih besar dari 2 
GB.

• Periksa apakah ukuran file gambar 300 KB atau lebih kecil.

337
File output failed. Confirm 
output file path.

Salah satu folder atau file berikut dengan nama yang sama dengan 
file yang akan dibuat ada di kartu SD atau memori USB tujuan 
penyimpanan.
• Folder yang menyimpan data
• File dengan perlindungan tulis
Hapus folder atau file di atas, atau ubah nama file yang akan dibuat.
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Kode 
kesalahan

Pesan kesalahan Tindakan

338
Modem is not connected 
correctly or the power is not 
turned on.

Tidak ada respons terhadap perintah yang menginisialisasi karena 
modem tidak tersambung dengan benar atau tidak dinyalakan.
• Konfirmasi koneksi modem.
• Nyalakan daya modem.

339
Failed to initialize the modem. 
Check initialization command.

Kesalahan dihasilkan dari modem karena perintah inisialisasi tidak valid.
• Konfirmasi perintah inisialisasi modem.

340 Printer error or power failure
Printer rusak atau catu daya printer belum dinyalakan.
• Konfirmasi printer.
• Nyalakan catu daya printer.

342
External power is not supplied 
to external I/O unit.

Terjadi kesalahan di unit antarmuka I/O eksternal.
•  Jika catu daya eksternal (24 V DC) tidak disuplai, suplai catu daya 

eksternal.
•  Jika catu daya eksternal disuplai, ganti unit antarmuka I/O eksternal.

343
External I/O unit installation 
error.
Check if firmly installed.

Unit antarmuka I/O eksternal tidak terpasang dengan benar.
Pasang unit antarmuka I/O eksternal dengan benar.

345
BCD/BIN conversion error 
Correct data

Setiap nilai yang tidak bisa dikonversi ke nilai BCD/BIN tidak 
ditampilkan/diinput.
• Ubah data perangkat yang akan ditampilkan ke nilai BCD.
• Koreksi nilai input menjadi bilangan bulat 4 digit.

360
0 divisor division error. Confirm 
operation expression.

Pembagian nol terjadi oleh ekspresi operasional data.
Tinjau ekspresi operasional data sehingga pembagi tidak menjadi 0.

361
Specified device No. is out of 
range.

Nomor file yang dimasukkan di luar rentang. Periksa nomor file yang 
dimasukkan, dan masukkan nilai valid (1 hingga 9999).

362
Invalid device value in time 
action setting

Jika pengontrol dikontrol dengan fungsi tindakan waktu GOT, nomor 
yang ditetapkan di luar rentang, atau nilai perangkat yang ditetapkan 
tentang pengaturan operasi di luar rentang atau tidak valid.
Setel nilai yang valid.

363
The file number exceeds the 
limitation. File output failed.

Hapus file dengan nomor file terbesar dan file yang tidak perlu.

370
Upper and lower limit value 
error.
Confirm value setting.

Pengaturan nilai batas bawah/atas adalah [Upper limit < Lower limit].
Koreksi pengaturan sehingga menjadi “Upper limit Lower limit”.

380
Insufficient USB drive capacity.
Confirm the drive capacity.

Memori yang tersedia di drive ekstensi tidak memadai.
Konfirmasi memori drive ekstensi yang tersedia, dan tingkatkan memori 
jika rendah.

381
USB drive is not installed or in a 
removable state.

Instal drive ekstensi jika tidak terinstal.
Instal ulang drive ekstensi jika dalam status dapat dipindah.
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LAMPIRAN

Kode 
kesalahan

Pesan kesalahan Tindakan

382 USB drive is not formatted.
Drive ekstensi tidak diformat atau diformat dengan tidak kompatibel 
dengan GOT.
Format ulang drive ekstensi.

383
Unable to overwrite. USB drive 
is write-protected

Drive ekstensi tak dapat ditulisi.
Batalkan perlindungan tulis drive ekstensi.

384
USB drive error. Replace USB 
drive.

Drive ekstensi rusak.
Ganti drive ekstensi.

401
An error response has been 
received from the connected 
device.

• Singkirkan penyebab kesalahan CPU.
•  Tinjau kondisi pengoperasian CPU, parameter, dan yang lainnya.

402
Communication timeout. 
Confirm communication 
pathway or modules.

Kesalahan batas waktu terjadi selama komunikasi.
•  Konfirmasi bahwa kabel tidak tersambung, status pemasangan unit 

komunikasi dan status PLC. 
Nomor saluran tidak ditampilkan dalam kode kesalahan atau 
pesan kesalahan jika terjadi kesalahan saat menggunakan fungsi 
multisaluran. 
Baca manual berikut untuk mengidentifikasi nomor saluran dalam 
kesalahan. 
→  GOT2000 Series Connection Manual for GT Works3 and a controller 

used (1.6 Checking for Normal Monitoring)
•  Kesalahan ini terjadi jika muatan CPU PLC menjadi lebih berat saat 

mengakses stasiun lain. Dalam kasus itu, transfer data stasiun lain 
tersebut ke stasiun host CPU PLC dan pantau di host.

• Taruh petunjuk COM jika pemindaian PLC panjang.
•  Periksa apakah versi driver komunikasi mendukung pengontrol. 

Untuk mengetahui cara memeriksa versi driver komunikasi, baca yang 
berikut. 
→ GT Designer3(GOT2000) Screen Design Manual

403
SIO status error. Confirm 
communication pathway or 
modules.

Kesalahan overrun, kesalahan bit paritas atau kesalahan flaming 
dihasilkan ketika komunikasi RS-422/RS-232 diterima.
Konfirmasi bahwa kabel tidak tersambung, status pemasangan unit 
komunikasi, status PLC, dan kecepatan transmisi link komputer.
Nomor saluran tidak ditampilkan dalam kode kesalahan atau pesan 
kesalahan jika terjadi kesalahan saat menggunakan fungsi multisaluran.
Baca manual berikut untuk mengidentifikasi nomor saluran dalam 
kesalahan.
→  GOT2000 Series Connection Manual for GT Works3 and a controller 

used (1.6 Checking for Normal Monitoring)

404
Response does not match 
communication request.

• Atasi wicara silang dalam saluran.
• Perpanjang batas waktu komunikasi.
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Kode 
kesalahan

Pesan kesalahan Tindakan

406
Specified station access is out 
of range. Confirm station no.

•  Nomor stasiun selain dari stasiun master/lokal ditetapkan dalam 
koneksi CC-Link (via G4).

•  CPU PLC selain dari QCPU diakses.;Konfirmasi nomor stasiun data 
project.

407
Accessed other network. 
Change network setting.

•  Saat memantau jaringan yang sama dengan GOT;GOT mengakses 
jaringan lain dengan MELSECNET/H, MELSECNET/10 (jaringan PLC ke 
PLC), atau koneksi Jaringan Pengontrol CC-Link IE. Konfirmasi nomor 
jaringan data project agar tidak mengakses jaringan lain.

•  Saat memantau jaringan lain;Konfigurasi ulang [Routing Information 
Setting] GT Designer3 atau [Routing Information Setting] GX 
Developer.

•  Saat menggunakan GT15-75J71LP23-Z/GT15-75J71BR13-Z; Jaringan 
lain tidak bisa dipantau.;Konfirmasi nomor jaringan data project agar 
tidak mengakses jaringan lain.

410
Cannot perform operation 
because of PLC run mode. Stop 
the PLC.

Operasi, yang tidak bisa dilakukan selama RUN CPU PLC dilakukan.
Stop CPU PLC.

411
Memory cassette is 
write-protected.
Check the memory cassette.

Kaset memori yang dipasang pada CPU PLC adalah EPROM atau 
E2PROM, dan tidak dalam status dilindungi.
Konfirmasi bahwa kaset memori terpasang pada CPU PLC.

412
Cannot read/write device 
protected by keyword. Remove 
keyword.

Kata kunci disetel di CPU PLC.
Batalkan kata kunci.

413
Unsupported CPU has been 
accessed.

• Periksa manual terbaru untuk melihat apakah CPU didukung.
• Tulis data paket yang dibuat dengan versi terbaru GT Designer3.

420 E71 specification is ASCII.
[ASCII code] dipilih dalam [Ethernet operations] pengaturan sisi PLC.
Pilih [Binary code].

421
E71 is set as read-only. Clear 
setting.

Unit Ethernet pada sisi PLC disetel dalam hanya baca.
Setel unit Ethernet pada sisi PLC disetel agar dapat ditulis.

422
Not communicating between 
CPU and E71. Confirm CPU 
error.

Kesalahan CPU PLC. Komunikasi antara CPU PLC dan sisi PLC unit 
Ethernet tidak memungkinkan.
Konfirmasi apakah ada kesalahan dalam CPU PLC oleh GX Developer dll. 
(Konfirmasi memori buffer)
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423
Insufficient network table 
information.
Add station no.

Nomor stasiun yang disetel dalam data project dan nomor stasiun 
yang disetel dalam perangkat nomor stasiun peralihan tidak ada dalam 
pengaturan Ethernet GT Designer3.
•  Tambahkan nomor stasiun yang disetel dalam data project ke 

pengaturan Ethernet GT Designer3.
•  Saat menggunakan fungsi peralihan nomor stasiun, periksa data 

perangkat nomor stasiun peralihan. 
Jika nomor stasiun yang ditetapkan dalam perangkat nomor stasiun 
peralihan tidak disetel dalam pengaturan Ethernet. tambahkan nomor 
stasiun ke pengaturan Ethernet. 
Jika nomor stasiun tidak ada dalam sistem, ubah data perangkat 
nomor stasiun peralihan. (Setel nomor stasiun agar sama dengan 
nomor stasiun unit Ethernet sisi PLC yang disetel dalam pengaturan 
parameter GX Developer.)

424

Same sta. on GOT & project 
data. 
Review communication 
parameter.

Nomor stasiun yang disetel dalam utility GOT sama dengan nomor 
stasiun yang disetel dalam pengaturan Ethernet GT Designer3 (nomor 
stasiun unit Ethernet sisi PLC) atau dalam data project.
Periksa konten berikut ini supaya beberapa nomor stasiun tidak boleh 
sama.
• Periksa nomor stasiun GOT dalam utility GOT.
• Periksa nomor stasiun yang ditetapkan dalam data project.
•  Periksa nomor stasiun yang disetel dalam data project. (Setel nomor 

stasiun agar sama dengan nomor stasiun unit Ethernet sisi PLC yang 
disetel dalam pengaturan parameter GX Developer.)

•  Saat menggunakan fungsi peralihan nomor stasiun, periksa data 
perangkat nomor stasiun peralihan.

425
A duplicate IP address has been 
detected. Confirm the setting.

GOT memiliki alamat IP yang sama dengan perangkat lain.
Ubah alamat IP GOT atau perangkat.

430
Wireless LAN unit is not 
mounted or a hardware error 
occurred.

Unit komunikasi LAN nirkabel tidak terinstal di antarmuka sisi.
Periksa apakah unit terinstal dengan benar.

431
Connectable access point is not 
found.

Periksa pengaturan untuk mengetahui titik akses, dan pengaturan 
koneksi LAN nirkabel.

432
Wireless LAN connection 
settings are not specified.

Setelah mengonfigurasi pengaturan koneksi LAN nirkabel, aktifkan 
fungsi koneksi LAN nirkabel.
→ GT Designer3(GOT2000) Screen Design Manual

433
Failed to authenticate the 
access point.

Periksa apakah metode autentikasi yang ditetapkan dalam pengaturan 
koneksi LAN sama dengan yang di sisi poin akses.
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434
GOT hardware version not 
supported by wireless LAN 
connection

Gunakan GOT dengan hardware versi B atau yang lebih baru.
Untuk mengetahui cara memeriksa versi hardware, rujuk ke yang 
berikut.
→ GOT2000 Series User’s Manual (Hardware)

440
The label information has been 
updated.

Resolusi nama label akan dijalankan secara otomatis.
Tunggu hingga selesai.

441
The specified CPU is updating 
the label information.

Informasi label global CPU yang ditetapkan akan diperbarui.
Tunggu hingga selesai.

442
Resolving the label information.
Do not turn off the power 
during the process.

Resolusi nama label sedang dijalankan.
Tunggu hingga selesai.

448
PLC cannot handle as 
requested.
Correct devices.

Perangkat di luar rentang file CPU PLC mendaftar dan memori buffer 
ditetapkan.
Koreksi perangkat monitor dengan menetapkan register file CPU PLC.

449
Dedicated device is out of 
range.
Confirm device range.

Tetapkan alamat untuk unit fungsi khusus dalam rentang monitor GOT 
yang tersedia.

450
Path has changed or timeout 
occurred in redundant system.

Jalur telah diubah dan batas waktu habis terjadi dalam sistem yang 
redundan.
• Periksa CPU PLC untuk mengetahui apakan jalur sudah dialihkan.
•  Periksa status sambungan kabel, status instalasi unit komunikasi, dan 

status CPU PLC.
•  Kesalahan ini dapat terjadi ketika muatan CPU PLC menjadi lebih 

berat saat mengakses stasiun yang lain. Dalam kasus itu, transfer data 
stasiun lain tersebut ke stasiun host CPU PLC dan pantau di host.

•  Lakukan salah satu operasi berikut jika waktu pemindaian PLC 
panjang: Instruksi COM/Ekstensi pemrosesan END/Pengaturan jumlah 
waktu pemrosesan untuk data umum/Pemrosesan batch pembaruan 
data.

451
Q redundant system settings 
and current config. Do not 
match.

Ubah pengaturan sistem redundan Q sesuai dengan sistem CPU 
redundan Q aktual.

460 Communication unit error
• Reset daya GOT.
• Ganti unit.

461
Communication error occurred 
between option units and the 
GOT.

Periksa manual berikut ini untuk mengetahui spesifikasi daya tahan 
terhadap getaran dan metode pemasangan unit opsi.
Setelah itu, reset catu daya GOT.
→ GOT2000 Series User’s Manual (Hardware)
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470
No routing params. 
Communication not 
established with specified sta.

Setel parameter perutean.

471
No IP address info. (Ethernet 
table) of connection 
destination.

Setel informasi jaringan tentang tujuan untuk [Ethernet setting].

480
Communication channel not 
set. Set channel number on 
Utility.

Saluran (CH.No.1 hingga 4) untuk berkomunikasi dengan pengontrol 
tidak disetel.
•  Setelah mengatur Pengaturan Komunikasi di GT Designer3, unduh ke 

GOT.
•  Ubah pemilihan saluran dalam Pengaturan Komunikasi di utility.

481
Communication unit not 
mounted to the slot of active 
channel.

Antarmuka di mana saluran (CH No.1 hingga 4) disetel tidak memiliki 
unit komunikasi yang terpasang.
•  Pasang unit komunikasi ke antarmuka tempat saluran (CH No.1 hingga 

4) disetel.
•  Ubah pemilihan saluran (CH No.1 hingga 4) dalam Pengaturan 

Komunikasi.

482
Too many same units are 
mounted.
Confirm the no of units.

Unit yang dipasang di GOT melebihi jumlah maksimum unit yang dapat 
dipasang.
Periksa jumlah unit, dan lepaskan unit yang tidak perlu.

483
Simultaneous mounting of the 
units are not allowed.

Dua atau lebih unit yang tidak boleh dipasang secara bersamaan di GOT 
dipasang.
Periksa unit yang dipasang, dan lepaskan unit yang tidak perlu.

484
Unit mounted incorrectly. Move 
the unit to correct position.

Unit tidak dipasang dalam posisi yang benar di GOT.
Konfirmasi posisi pemasangan unit.

485
Too many units mounted on 
GOT.
Reduce units.

Unit yang dipasang di GOT melebihi jumlah maksimum unit yang dapat 
dipasang.
Periksa jumlah unit, dan lepaskan unit yang tidak perlu.

486
Communication unit 
not corresponded to set 
communication driver.

Driver komunikasi yang disetel dalam Pengaturan Komunikasi dan unit 
komunikasi yang dipasang di GOT tidak sesuai.
•  Periksa apakah driver komunikasi yang disetel di Pengaturan 

Komunikasi sudah benar.
•  Periksa apakah ada unit komunikasi yang tidak benar yang sudah 

terpasang di GOT.

487
Please turn on the PLC and the 
GOT again.

Matikan kembali PLC dan GOT.

488
Too many units mounted on 
GOT.
Reduce units.

Unit yang dipasang di GOT melebihi jumlah maksimum unit yang dapat 
dipasang. Periksa jumlah unit, dan lepaskan unit yang tidak perlu.
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489
Inactive channel has been 
selected at Communication 
Settings.

Sudah disetel no. saluran komunikasi yang tidak aktif di data project.
•  Periksa apakah No. saluran yang tidak perlu disetel dalam data project.
•  Periksa apakah No. saluran yang disetel dalam data project disetel 

dalam Pengaturan Komunikasi.

492
Unusable communication units 
are mounted.

Unit yang tidak dapat digunakan untuk GOT terpasang.
Lepaskan unit yang tidak dapat digunakan.

493
Installation of extension units 
may be inappropriate.

Periksa apakah unit ekstensi terpasang dengan kencang di GOT.

497
Failed to start communication 
driver(s).

Instal lagi driver komunikasi.

500
Warning! Built-in battery 
voltage is low.

Voltase baterai bawaan GOT berkurang.
Ganti baterai bawaan GOT.

506
Warning! Backlight needs 
replacement.

GS khusus memberi tahu bahwa waktu tambahan lampu latar menyala 
telah mencapai atau melebihi waktu yang disetel.
Silakan hubungi pusat servis atau perwakilan Mitsubishi setempat.
GOT bisa dipulihkan dengan menjalankan fungsi reset waktu tambahan. 
GOT juga bisa dipulihkan dengan mematikan sinyal notifikasi secara 
manual. Dalam kasus itu, MATIKAN setelah menetapkan nilai yang lebih 
besar dari waktu tambahan.

510 Clock data input out of range

Nilai yang diinput sebagai data jam di luar rentang input yang 
diaktifkan.
Dalam kasus ini, nilai input itu tidak diterima.
Konfirmasi rentang input nilai yang akan diinput sebagai data jam, dan 
input lagi nilai yang tepat.

522
Unnecessary file deleted to 
create new file.

File lama dengan konten berbeda sudah dihapus dan file baru sudah 
dibuat.
Harap diperhatikan bahwa file lama dihapus dan file baru dibuat jika file 
dengan nama yang sama dengan konten berbeda ada saat membuat 
file.

523
The read alarm log file has 
a different number of alarm 
points.

Jika pengaturan alarm (termasuk jumlah alarm yang dipantau dan 
hierarkinya) diubah, file log alarm sebelum perubahan dibacakan, tapi 
alarm dikumpulkan berdasarkan pada pengaturan baru.
Alarm yang ditampilkan setelah perubahan mungkin berbeda dari 
alarm sebelum perubahan.
Hapus file log alarm jika perlu.

525
Unable to read/write alarm log 
files under different projects.

Tidak dapat membaca file log alarm yang disimpan oleh project 
berbeda.
Konfirmasi file log alarm dan tempat untuk menyimpan file log alarm.
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526 File conversion failed.
File yang ditetapkan untuk konversi file tidak ada.
Periksa pengaturan untuk menentukan file yang akan dikonversi.

527 Insufficient SRAM capacity.
Kapasitas untuk area pengguna SRAM tidak memadai.
Konfirmasi memori yang tersedia di area pengguna SRAM.

528
Error in SRAM.
Failed to write data.

Kesalahan mungkin disebabkan oleh kerusakan dalam unit utama GOT.
Hubungi perwakilan Mitsubishi setempat.

529
Data error in SRAM. Check the 
battery life.

Kesalahan dalam data SRAM akibat rendahnya voltase baterai, dll.
Konfirmasi status baterai.

532
Cannot access the files.
Check the memory card.

Periksa apakah nama file tepat.
Nama file mengandung karakter yang tidak valid.
Untuk tipe karakter dan jumlah karakter yang tersedia untuk nama file, 
baca yang berikut.
→ GT Designer3(GOT2000) Screen Design Manual

533
Cannot access Files. Check the 
memory card

•  Masukkan kartu SD atau memori USB.
•  Tutup penutup kartu SD agar kartu SD dapat diakses.
•  Jika kartu SD atau memori USB memiliki file yang tidak perlu, hapus 

file tersebut.

535 Cannot open image file. Periksa apakah file target disimpan di kartu SD atau memori USB.

536
Image file error or invalid file 
format.

•  Konfirmasi apakah file gambar dalam kartu SD atau memori USB 
normal.

•  Konfirmasi apakah ada file gambar dengan format yang tidak valid 
disimpan.

562
Install the font appropriate for 
the specified system language.

Tidak ada font yang tepat untuk sistem bahasa yang ditetapkan dalam 
peralihan bahasa sistem yang terinstal.
Instal font yang tepat.

565
Files for the extended system 
application are missing.

Instal kembali aplikasi sistem (fungsi tambahan) yang gagal Anda 
jalankan.

571
Capacity shortage of user 
memory (RAM)

Tidak ada area/ruang kosong di drive D.
Format drive D dalam memori untuk mendapatkan area kosong.

577
Newly readable records do not 
exist.

Ruang untuk membaca rekaman tidak memadai.
Hapus rekaman yang tidak perlu.

578
The specified record name is 
invalid.
Check the record name.

Rekaman kosong tanpa nama dan nilai perangkat tidak ada.
Setel rekaman kosong tersebut di muka.

579
Recipe is in process. Cannot 
operate the recipe file.

Pemrosesan resep lain sedang berlangsung.
Setelah pemrosesan selesai, lakukan lagi operasi file resep.

580
Selected recipe setting is not 
the recipe file operation target.

Pengaturan resep yang ditetapkan tidak memiliki file resep G2P.
Tetapkan file G2P.
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581 Abnormal Advanced recipe file
Resep tidak bisa dijalankan untuk file resep dengan konten yang salah. 
Hapus file resep dari kartu SD atau memori USB.

582
Cannot generate Advanced 
recipe file.

Tidak dapat menghasilkan file resep. Konfirmasi yang berikut dan 
jalankan kembali pemrosesan resep.
• Konfirmasi apakah kartu SD atau memori USB terpasang.
• Tutup penutup kartu SD agar kartu SD dapat diakses.
• Konfirmasi memori kartu SD atau memori USB yang tersedia.

583
Unable to save device value to 
Advanced recipe file.

Tidak dapat menyimpan nilai ke file resep.
• Konfirmasi perlindungan dari penulisan kartu SD atau memori USB.
• Konfirmasi apakah atribut menyimpan file hanya untuk membaca.

584 Advance recipe file save error
Terjadi kesalahan selama penulisan file resep. Jangan tarik kartu SD atau 
memori USB saat Resep sedang beroperasi.

585
Advanced recipe file upload 
error

Terjadi kesalahan selama pembacaan file resep.
Jangan tarik kartu SD atau memori USB saat Resep sedang beroperasi.

586
Specified Advanced recipe 
number does not exist.

Resep nomor yang tidak ada akan dijalankan.
Jalankan resep nomor yang ada.

587
Specified record number does 
not exist.

Rekaman tingkat lanjut nomor yang tidak ada akan dijalankan.
Jalankan rekaman nomor yang ada.

588
Cannot save recipe data to read 
only record.

Menyimpan resep akan dijalankan ke rekaman yang nilai perangkat 
resepnya tidak bisa diedit.
Buat nilai perangkat resep rekaman dapat diedit dengan Pengaturan 
Resep GT Designer3 atau tetapkan rekaman yang nilai perangkat 
resepnya bisa diedit.

589
Recipe device save error. Recipe 
file does not exist.

Menyimpan resep akan dijalankan ke pengaturan resep yang disetel 
karena tidak menggunakan file.
Tentukan pengaturan resep yang menggunakan file.

590
Recipe device upload error. 
Recipe device value does not 
exist.

Memuat resep akan dijalankan ke rekaman yang nilai perangkat 
resepnya tidak disetel.
Tentukan rekaman yang nilai perangkat resepnya tidak disetel.

591
Advanced Recipe error. Check 
recipe data.

Pengaturan resep tidak benar.
Konfirmasi pengaturan resep data project dan unduh lagi ke GOT.

592
The extension specified to the 
recipe file is invalid.

Periksa apakah nama file tepat.
Nama file mengandung karakter yang tidak valid. Untuk detailnya, baca 
yang berikut.
→ GT Designer3(GOT2000) Screen Design Manual
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593
The setting of G1P file of the 
original diversion is different 
from the project data.

Pengaturan sourcMatch, pengaturan file resep tingkat lanjut, dan 
pengaturan file resep GOT2000, atau hapus file resep tingkat lanjut yang 
tidak perlu dari kartu memori.e file resep tingkat lanjut tidak sesuai 
dengan file resep GOT2000, atau tidak tepat.

595 Logging file error.
Kesalahan pencatatan file.
Saat mengumpulkan data lagi, hapus file pencatatan dan file 
manajemen.

596
Logging setting does not exist 
or setting value error.

Pengaturan pencatatan tidak ada atau kesalahan nilai pengaturan.
Tentukan pengaturan pencatatan yang ada dalam pengaturan grafik 
tren historis dan pengaturan daftar data historis.

597
The specified logging ID does 
not exist.

•  Tentukan ID pencatatan dalam perangkat Kontrol Eksternal ID 
Pencatatan.

•  Pilih fungsi offset grafik untuk menentukan ID pencatatan yang ada 
dalam pengaturan pencatatan

598
The specified logging setting is 
incompatible.

•  Konfigurasi pengaturan agar jumlah perangkat pencatatan yang 
ditetapkan untuk ID pencatatan melebihi jumlah yang perangkat 
pencatatan dalam saluran data di grafik tren historis.

•  Konfigurasi pengaturan agar tipe data perangkat pencatatan yang 
ditetapkan untuk ID pencatatan sama dengan tipe data perangkat 
yang ditentukan dalam grafik tren historis.

601 Printer unit error.

Unit printer tidak terinstal dengan benar. Memori flash bawaan unit 
printer rusak atau masa pakai yang dijamin sudah lewat.
Periksa apakah unit printer terinstal dengan benar.
Jika unit printer sudah terinstal dengan benar, memori flash bawaan 
rusak atau masa pakai yang dijamin sudah lewat. Ganti unit printer 
dengan yang baru.

602 Video/RGB unit not mounted
•  Periksa apakah unit input video/RGB sudah terpasang.
•  Periksa apakah GOT yang digunakan mendukung input video/RGB.

603 External I/O unit error Periksa apakah unit I/O eksternal terpasang dengan benar.

604 Sound output unit error Periksa apakah unit output terpasang dengan benar.

605 USB device I/F error
Kesalahan mungkin disebabkan oleh kerusakan dalam GOT.
Hubungi perwakilan Mitsubishi setempat.

606
Multimedia processing unit is 
not mounted.

Unit multimedia tidak terpasang dengan benar.
Periksa apakah unit multimedia terpasang dengan benar.

607
Video · RGB input object has 
too many. Please reduce the 
number of settings.

Kurangi jumlah objek tampilan video/RGB yang akan ditampilkan secara 
bersamaan.
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608
Hierarchical relationship of 
video · RGB input object can 
not be represented correctly.

Make sure that multiple video/RGB display objects do not overlap each 
other.

610 Insufficient memory capacity.
Kapasitas memori untuk fungsi antarmuka MES tidak memadai.
Hapus file yang tidak perlu, dan buat backup memori.

611
Improper job files. Confirm job 
setting.

Konten untuk file pekerjaan tidak cocok dengan pengaturan untuk file 
pekerjaan. Periksa apakah ada kesalahan dalam pengaturan di layar 
pengaturan.

612
Cannot access Logging Files. 
Check the memory card.

•  Masukkan kartu SD atau memori USB.
•  Tutup penutup kartu SD agar kartu SD dapat diakses.
•  Jika kartu SD atau memori USB memiliki file yang tidak perlu, hapus 

file tersebut.

613 Error in writing logfile
•  Masukkan kartu SD atau memori USB.
•  Tutup penutup kartu SD agar kartu SD dapat diakses.
•  Periksa apakah kartu SD atau memori USB dapat ditulis.

614 Error in reading logfile
•  Masukkan kartu SD atau memori USB.
•  Tutup penutup kartu SD agar kartu SD dapat diakses.
•  Periksa apakah kartu SD atau memori USB dapat dibaca.

615
Cannot connect to MES Server.
Check the Server.

•  Server tidak berfungsi normal atau jalur koneksi ke server dibuat 
dengan tidak benar.

•  Periksa kondisi pengoperasian server.
•  Periksa jaringan ke server.

616
Cannot connect to SNTP Server.
Check the Server.

•  Pengaturan untuk server SNTP salah atau jaringan ke server SNTP 
dibuat dengan tidak benar.

•  Periksa kondisi pengoperasian server SNTP.
•  Periksa jaringan ke server SNTP.

620 Trial connection has started.

Saat nomor lisensi fungsi GOT Mobile tidak terdaftar, GOT diakses oleh 
perangkat informasi.
Untuk menggunakan fungsi GOT Mobile dalam versi lengkap, daftarkan 
nomor lisensi di GOT.

630 Failed to save a video file.
Periksa area kartu CF yang tersedia, status instalasi, pembatalan 
perlindungan dari penulisan, status format, dan jumlah file yang 
disimpan.

631
Failed to save a video file on 
network.

Periksa status aktivasi software penautan komputer pribadi di server 
file, pengaturan fungsi FTP Ethernet GOT, pengaturan jaringan GOT, dan 
server file serta area kartu SD yang tersedia yang terinstal di unit utama 
GOT.

632
Error detected during 
multimedia processing.

Matikan GOT dan periksa status instalasi unit multimedia, atau ubah 
unit multimedia.
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633
The version of the unit software 
is not the latest.

Instal software terbaru unit multimedia yang kompatibel menggunakan 
utility di GOT.

634

No space remaining in 
the multimedia CF card. 
Terminating long time 
recording.

Ubah kartu CF yang diinstal di unit multimedia atau hapus file yang 
tidak perlu.

640
An error occurred in a FTP client 
process.

Konfigurasi ulang pengaturan GOT (klien FTP).
Periksa status pengoperasian dan saluran jaringan server FTP.
Untuk detail kesalahan, periksa register khusus GOT GS989 (notifikasi 
kesalahan komunikasi FTP).
→ GT Designer3(GOT2000) Screen Design Manual

641
The license key has not been 
registered. Confirm your 
license.

Di GOT, daftarkan nomor lisensi untuk fungsi server VNC, fungsi 
pengoperasian komputer pribadi jarak jauh (Ethernet), fungsi 
antarmuka MES, atau fungsi GOT Mobile.

650
The operator management 
information file is invalid.

Siapkan file informasi manajemen operator normal dan impor, atau 
simpan file informasi manajemen operator ke lokasi yang ditentukan.

651
Cannot access the operator 
management information file.

Periksa apakah drive tujuan yang menyimpan file informasi manajemen 
operator yang ditentukan dapat diakses oleh GOT.

660
Failed to obtain op. authority. 
Server does not respond.

Pastikan GOT master telah tersambung dan dimulai.
Pastikan bahwa fungsi interaksi jaringan GOT diaktifkan di GOT master.

670
Current alarms exceeded the 
max no. that can be procd. at a 
time.

Seratus atau lebih alarm sistem terjadi bersamaan.
Hilangkan penyebab output alarm sistem dan periksa lagi alarm sistem.

697
Package writing of the old 
version is not allowed.

Instal versi terbaru GT Designer3, lalu jalankan lagi operasi.

698 Insufficient CoreOS version. Instal versi terbaru CoreOS.

699 Insufficient BootOS version. Instal versi terbaru BootOS.

800 Abnormal module status
Baca penjelasan tentang SB0020 di manual jaringan yang relevan.
Untuk CC-Link IE Field Network, baca manual MELSEC-Q CC-Link IE Field 
Network master/unit lokal.

801 Abnormal baton passing status Baca penjelasan tentang SB0047 di manual jaringan yang relevan.

802
Abnormal cyclic transmission 
status

Baca penjelasan tentang SB0049 di manual jaringan yang relevan.

803 Transient error Baca penjelasan tentang SB00EE di manual jaringan yang relevan.

804
The cable on the IN side 
is disconnected or is not 
connected.

Baca penjelasan tentang SB0067 di manual jaringan yang relevan.
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Kode 
kesalahan

Pesan kesalahan Tindakan

805
The cable on the OUT side 
is disconnected or is not 
connected.

Baca penjelasan tentang SB0068 di manual jaringan yang relevan.

840 PROFIBUS master is not started. Aktifkan master PROFIBUS.

841
I/O setting of the PROFIBUS 
master and slaves do not 
match.

•  Gunakan file GSD, sebuah file konfigurasi yang disediakan oleh 
MITSUBISHI. (Dilarang mengedit)

• Koreksi pengaturan yang relevan, matikan lalu nyalakan GOT.

850 CC-Link switch setting error
• Periksa apakah pengaturan sakelar tidak memiliki kesalahan.
•  Periksa kode kesalahan yang disimpan di SW006A.
• Baca penjelasan tentang SB006A di manual jaringan yang relevan.

851
Abnormal cyclic transmission 
status

•  Periksa apakah resistor yang mengakhiri tersambung.
•  Periksa kode kesalahan untuk CPU PLC.
•  Periksa parameter untuk CPU PLC di stasiun master.
•  Periksa status kesalahan stasiun master.
•  Baca penjelasan tentang SB006E di manual jaringan yang relevan.

852 Abnormal host line status
•  Periksa apakah kabel terpasang atau tidak.
•  Baca penjelasan tentang SB0090 di manual jaringan yang relevan.

853 Transient error
•  Periksa apakah status terjadinya kesalahan transien untuk setiap 

stasiun yang disimpan di SW0094 hingga SW0097.
•  Baca penjelasan tentang SB0094.

860
Off line or the network power is 
off.

• Periksa status modul indikator LED.
• Aktifkan jaringan.
• Periksa apakah kabel tersambung dengan benar.
•  Sesuaikan kecepatan komunikasi GOT ke kecepatan peralatan master.

861 No connections are established.
• Periksa pengaturan peralatan master.
• Aktifkan peralatan master.

862 Critical link error
Pengontrol gagal atau mengalami kesalahan yang menonaktifkan 
komunikasi jaringan. (ID MAC terduplikasi, atau Bus-off terdeteksi.) 
Periksa pengontrol.

863 Incomplete configuration
Pengaturan pengontrol tidak dikonfigurasi, atau pengaturan tidak 
memadai atau tidak tepat.
Tinjau pengaturan pengontrol.

864 Unrecoverable fault(s) Pengontrol mengalami kesalahan yang tak dapat dikoreksi.

865 Recoverable fault(s)
Kesalahan otomatis dikoreksi.
Jika indikator LED status modul tidak berubah hijau, pengontrol 
mungkin mengalami kerusakan.
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Pasang GOT dengan mempertimbangkan dimensi dalam panel kontrol dan area terlarang pemasangan.
Bergantung pada tipe kabel koneksi yang disambungkan ke GOT, jarak lebih dari dimensi yang diuraikan mungkin 
diperlukan.
Pasang GOT dengan mempertimbangkan dimensi konektor dan radius tekukan kabel.

2 Memotong panel
 ● GT2715-X

Buka lubang pemasangan di panel kontrol dengan dimensi seperti yang ditunjukkan di bawah ini.

A
B

CC
C

C

A

B

C
C

CC

Horizontal Vertikal
Satuan: mm

Model A B C Ketebalan panel

GT2715-X
383,5
(+2, 0)

282,5
(+2, 0)

10 atau Lebih 1,6 hingga 4

Dimensi C menampilkan ukuran untuk memasang fitting di panel kontrol.

LAMPIRAN 2 PEMASANGAN DAN PELEPASAN
1 Petunjuk Keselamatan Pemasangan



LAMPIRAN 2-2

 ● GT2712-S, GT2710-S, GT2710-V, GT2708-S, GT2708-V, GT2705-V
Buka lubang pemasangan di panel kontrol dengan dimensi seperti yang ditunjukkan di bawah ini.

A

B
C

C

A

BC C

Horizontal Vertikal
Satuan: mm

Model A B C Ketebalan panel

GT2712-S
302

(+2, 0)

228

(+2, 0)

10 atau Lebih 1,6 hingga 4

GT2710-S, GT2710-V
289

(+2, 0)

200

(+2, 0)

GT2708-S, GT2708-V
227

(+2, 0)

176

(+2, 0)

GT2705-V
153

(+2, 0)

121

(+2, 0)

Dimensi C menampilkan ukuran untuk memasang fitting di panel kontrol.
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3 Posisi Pemasangan

Untuk memasang GOT, diperlukan jarak antara GOT dan perangkat lain.

 ● GT27
Bergantung pada unit dan kabel yang digunakan untuk GOT, jarak lebih dari dimensi yang diuraikan mungkin 
diperlukan.
Pasang GOT dengan mempertimbangkan dimensi konektor dan radius tekukan kabel.
Untuk jarak tarik kabel dari bagian bawah GOT, baca yang berikut.
→ GOT2000 Series User’s Manual (Hardware)
Untuk pemasangan vertikal, instal GOT sehingga panah pemasangan vertikal dicetak di permukaan belakang 
mengarah ke atas.
→ GOT2000 Series User’s Manual (Hardware)

B

ED

A

C

Ketebalan panel: 1,6 hingga 4

Satuan: mm

Horizontal

B

D

E
A

C

Vertikal Ketebalan panel: 1,6 hingga 4

Satuan: mm

Tabel berikut ini mencantumkan jarak yang diperlukan antara GOT dan perangkat lain.
Dimensi di dalam tanda kurung berlaku jika tidak ada peralatan yang menghasilkan noise terpancar (seperti 
kontraktor) atau panas yang terpasang di dekat GOT.
Namun, selalu jaga suhu sekitar GOT hingga 55°C atau lebih rendah.
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Satuan: mm

Item

GT27

GT2715-X GT2712-S
GT2710-S, 

GT2710-V

GT2708-S, 

GT2708-V
GT2705-V

A

Hanya GOT
48 atau lebih

[18 atau lebih]

48 atau lebih  

[29 atau lebih]
59 atau lebih

Unit koneksi bus 

dipasang

48 atau lebih

[18 atau lebih]

23 atau lebih  

[29 atau lebih]
48 atau lebih

Unit koneksi seri 

dipasang

48 atau lebih

[18 atau lebih]
47 atau lebih

Unit komunikasi CC-

Link (GT15-J61BT13) 

dipasang

48 atau lebih

[18 atau lebih]

50 atau lebih  

[22 atau lebih]

Unit komunikasi 

MELSECNET/H (koaksial) 

dipasang*1

48 atau lebih

[18 atau lebih]

48 atau lebih  

[38 atau lebih]

48 atau lebih  

[45 atau lebih]
67 atau lebih 81 atau lebih

Komunikasi 

MELSECNET/Hn

unit(optikal) dipasang*2

48 atau lebih

[18 atau lebih]
77 atau lebih

Unit komunikasi 

Jaringan Pengontrol IE 

CC-Link dipasang

48 atau lebih

[18 atau lebih]
55 atau lebih

Unit komunikasi Bidang 

Jaringan IE CC-Link 

dipasang

48 atau lebih

[18 atau lebih]
55 atau lebih

Unit input video 

dipasang*1

48 atau lebih

[18 atau lebih]

48 atau lebih  

[38 atau lebih]

48 atau lebih  

[45 atau lebih]
67 atau lebih -

Unit input RGB 

dipasang*3

48 atau lebih

[18 atau lebih]
-

Unit input Video/RGB 

dipasang*1*3 

48 atau lebih

[18 atau lebih]

48 atau lebih  

[38 atau lebih]

48 atau lebih  

[45 atau lebih]
67 atau lebih -

Unit output RGB 

dipasang*3

48 atau lebih

[18 atau lebih]
-

Unit multimedia 

dipasang*1

48 atau lebih

[18 atau lebih]

48 atau lebih  

[38 atau lebih]

48 atau lebih  

[45 atau lebih]
67 atau lebih -

Unit printer dipasang
48 atau lebih

[18 atau lebih]

Unit I/O eksternal 

dipasang

48 atau lebih

[18 atau lebih]

Unit output suara 

dipasang

48 atau lebih

[18 atau lebih]

B
Horizontal: 78 atau lebih [18 atau lebih]

Vertikal: 48 atau lebih [18 atau lebih]
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Satuan: mm

Item

GT27

GT2715-X GT2712-S
GT2710-S, 

GT2710-V

GT2708-S, 

GT2708-V
GT2705-V

C

Jika kartu SD digunakan
50 atau lebih

[20 atau lebih]
50 atau lebih 100 atau lebih

Jika kartu SD tidak 

digunakan

50 atau lebih

[20 atau lebih]

D
Horizontal: 50 atau lebih [20 atau lebih]

Vertikal: 80 atau lebih [20 atau lebih]

E*4
100 atau lebih

[20 atau lebih]

*1 Nilai ini adalah untuk kabel koaksial 3C-2V (JIS C 3501). 
Untuk spesifikasi kabel, baca GOT2000 Series Connection Manual untuk pengontrol yang digunakan.

*2 Nilai ini berbeda bergantung pada kabel yang digunakan.
*3 Nilai ini berbeda bergantung pada kabel yang digunakan. 

Jika radius penekukan kabel lebih besar dari nilai yang ditetapkan di atas, terapkan nilai saat kabel digunakan.
*4 Saat membuka atau menutup penutup baterai: 72 atau lebih.
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 ● GT27
Pasang GOT dengan bagian tampilannya diposisikan seperti di bawah ini.
Menggunakan GOT dengan sudut pemasangan selain dari yang berikut ini mempercepat kemunduran GOT.

Jika unit multimedia (GT27-MMR-Z), unit komunikasi MELSECNET/H (GT15-J71LP23-25, GT15-J71BR13), atau 
unit komunikasi CC-Link (GT15-J61BT13) dipasang, suhu sekitar pengoperasian harus lebih rendah 5°C dari suku 
maksimum 55°C yang ditetapkan dalam spesifikasi umum.

(1) Memasang GOT secara horizontal
Jika GOT dipasang pada sudut dari 60° hingga 105°, suhu dalam panel kontrol harus tidak lebih dari 55°C.
Jika GOT dipasang di luar sudut dari 60° hingga 105°, suhu dalam panel kontrol harus tidak lebih dari 40°C.

GOT

Bagian 
layar

Panel kontrol 
atau lainnya

105°

60°

(2) Memasang GOT secara vertikal
Jika GOT dipasang 90° derajat, , suhu dalam panel kontrol harus tidak lebih dari 55°C.
Jika GOT dipasang pada selain dari 90°, suhu dalam panel kontrol harus tidak lebih dari 40°C.

GOT

Bagian 
layar

Panel kontrol 
atau lainnya

90°

4 Panel Kontrol Suhu Dalam dan Sudut Pemasangan GOT
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5 Memasang GOT

 ● GT27

Bukaan panel

GOT
1 Masukkan permukaan belakang GOT ke dalam 

bukaan panel.

 ● Untuk GT2715-X (8 fitting) 2 Saat menempatkan fitting pada lubang 
pemasangan GOT, kencangkan sekrup di dalam 
rentang torsi yang ditentukan (0,36 N·m hingga 
0,48 N·m).
Mengencangkan sekrup dengan torsi melebihi 
rentang torsi yang ditentukan dapat merusak 
bentuk panel depan GOT, mengakibatkan 
lembar pelindung menjadi berkerut.

 ● Untuk GT27 kecuali GT2715 -X (4 fitting)

3 Lepaskan film pelindung dari GOT.



LAMPIRAN 2-8

6 Melepaskan GOT

 ● GT27
 ● Untuk GT2715-X (8 fitting)

1 Lepaskan sekrup dari GOT.
Lepaskan fitting dari GOT.

 ● Untuk GT27 kecuali GT2715-X (4 fitting)

Bukaan panel

GOT
2 Lepaskan GOT dari bukaan panel.
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7 Memasukkan/Melepaskan Kartu SD

Prosedur untuk memasukkan kartu SD ditunjukkan di bawah ini.

 ● GT27

(a) 

1 Buka penutup kartu SD seperti ditunjukkan di 
kiri.
(Sisi belakang GOT menghadap ke atas dalam 
gambar.)

Buka penutup
antarmuka kartu SD
90 derajat atau lebih.

LED akses
kartu SD

2 Setelah memastikan bahwa LED akses kartu SD 
mati dengan penutup kartu SD 90 derajat atau 
lebih terbuka, masukkan kartu SD dengan sisi 
atasnya menghadap ke atas.

3 Tekan dan tutup penutup kartu SD hingga 
terdengar suara klik.

4 Jika penutup kartu SD tertutup, akses ke kartu 
SD diizinkan.
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Prosedur untuk melepaskan kartu SD ditunjukkan di bawah ini.

 ● GT27

(a) 

1 Buka penutup kartu SD seperti ditunjukkan di 
kiri.

Buka penutup
antarmuka kartu SD
90 derajat atau lebih.

LED akses
kartu SD

2 Setelah memastikan bahwa LED akses kartu 
SD mati dengan penutup kartu SD 90 derajat 
atau lebih terbuka, tekan kartu SD untuk 
melepasnya

3 Tutup penutup antarmuka kartu SD.
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8 Pengkabelan Catu Daya ke GOT

Yang berikut ini menunjukkan contoh-contoh pengkabelan kabel daya, kabel tanah, dan kabel lain ke terminal catu 
daya GOT.

 ● GT27

INPUT
100-240 V AC

GOT

INPUT
24 V DC

Sekring
Untuk 200 V AC

+-

Kabel tanah
Pembumian

Untuk 24 V DC
GOT

+-

INPUT
24 V DC

Untuk 24 V DC (GT2705)
GOT

 ~ Petunjuk Keselamatan (GT27)

(1) Perlakukan terhadap kabel daya
Untuk kabel 200 V AC, dan 24 V DC, gunakan kabel setebal mungkin (Penampang kabel: 0,75 hingga 2 mm2), dan 
pastikan memilinnya ke terminal.
Untuk mencegah terjadinya hubungan pendek karena sekrup yang longgar, gunakan terminal tanpa patri dengan 
selubung insulasi.

(2) Pembumian
Setelah menyambungkan terminal LG dan terminal FG, pastikan untuk menyambungkannya ke tanah.
Jika tidak, sistem rentan terhadap noise.
Terminal LG memiliki potensi setara dengan setengah voltase input.
Oleh karena itu, menyentuh terminal dapat mengakibatkan kejut listrik.
Untuk GT2705-V, hanya hubungkan terminal FG karena model ini tidak memiliki terminal LG.

Untuk informasi detail tentang perlakuan terhadap kabel daya dan pembumian, lihat manual berikut.
→GOT2000 Series User’s Manual (Hardware)
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Kesalahan pembacaan panel sentuh dapat dikoreksi.
Biasanya, penyesuaian tidak diperlukan. Namun, perbedaan antara posisi yang disentuh dan posisi objek dapat terjadi 
seiring berselangnya periode penggunaan.
Bila perbedaan antara posisi yang disentuh dan posisi objek terjadi, koreksi posisi dengan fungsi ini.

Run Stop StopRun

Sebelum penyesuaian Setelah penyesuaian

[Run] akan beroperasi meski Anda
bermaksud menyentuh tombol [Stop].

Tombol [Stop] bisa disentuh
tanpa kesalahan.

(1) Prosedur untuk menyesuaikan koordinat panel sentuh

1

1 Sentuh [Utility call key].

2

2 Sentuh [Touch panel calibration] di layar 
[Maintenance] di [Utility main menu].

LAMPIRAN 3 KALIBRASI PANEL SENTUH
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3 Sentuh bagian tengah  yang ditampilkan di 
kiri atas secara akurat.

4 Sentuh titik  yang ditampilkan di kanan atas.

5 Sentuh titik  yang ditampilkan di kiri bawah.



LAMPIRAN 3-3

6 Sentuh titik  yang ditampilkan di kanan 
bawah.

7 Menyentuh tombol  yang ditampilkan 
di kanan atas mengembalikan ke layar 
sebelumnya.
Saat penyentuhan akurat tidak bisa dilakukan, 
sentuh tombol [Readjustment] untuk membuat 
lagi pengaturan dari 3 .
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LAMPIRAN 4 KATALOG DAN MANUAL YANG 

RELEVAN
Katalog seri GOT2000

Nama katalog Nomor katalog

Graphic Operation Terminal GOT2000 Series L(NA)08270ENG

Graphic Operation Terminal Screen Design Software MELSOFT GT Works3 L(NA)08170ENG

Manual seri GOT2000 yang relevan

Nama manual Nomor manual

GOT2000 Series User’s Manual (Hardware) SH-081194ENG

GOT2000 Series User’s Manual (Utility) SH-081195ENG

GOT2000 Series User’s Manual (Monitor) SH-081196ENG

GOT2000 Series Connection Manual (Mitsubishi Products) For GT Works3 Version1 SH-081197ENG

GT Designer3(GOT2000) Screen Design Manual SH-081220ENG
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LAMPIRAN 5 PERAKITAN PERALATAN PELATIHAN 

PRAKTIS
Lampiran ini menguraikan spesifikasi dan metode sambungan peralatan pelatihan praktis yang digunakan di “Satellite 
Training System Part 3: GOT”.

Konfigurasi peralatan
● Pemutus tanpa sekring: NF30-FA (2 P, 10 A) oleh Mitsubishi Electric Corporation

● Pengontrol terprogram: MELSEC iQ-R oleh Mitsubishi Electric Corporation

● Graphic operation terminal: GT2708-STBA oleh Mitsubishi Electric Corporation

● Sakelar stop darurat

Diagram sambungan peralatan pelatihan praktis

Pemutus tanpa sekring
NF30-FA (Mitsubishi Electric Corporation)

Catu daya AC fase tunggal
200 V AC

L N

2 4

1 3

INPUT AC

INPUT AC

Pembumian

Graphic operation terminal
GT2708-STBA 
(Mitsubishi Electric Corporation)

Pengontrol terprogram
MELSEC iQ-R
 (Mitsubishi Electric Corporation)

Kabel Ethernet

Kabel USB

Komputer pribadi

L1 N1
→

Sakelar 
stop darurat

24 V DC 
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Prosedur sambungan peralatan pelatihan praktis
1. Pasang kabel daya (200 V AC) di sisi utama pemutus tanpa sekring
2. Pasang terminal input daya PLC dan GOT di sisi sekunder pemutus tanpa sekring.
3. Pasang kabel sakelar stop darurat.
4. Sambungkan komputer pribadi dan GOT dengan kabel USB.
5. Sambungkan GOT dan PLC dengan kabel Ethernet.

Untuk pengaturan komunikasi antara komputer pribadi dan GOT, baca “2.1.1 Menyambungkan komputer pribadi ke 
GOT” dalam teks ini.
Untuk pengaturan komunikasi antara GOT dan PLC, baca “2.2.1 Menyambungkan GOT dan PLC” dalam teks ini.



Merek dagang dan merek dagang terdaftar
Nama produk dan perusahaan merupakan merek dagang atau merek dagang terdaftar masing-masing pemiliknya.

Warna aktual mungkin sedikit berbeda dari gambar di katalog ini.
Tampilan aktual mungkin berbeda dari yang ditunjukkan di gambar layar GOT.
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